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Welcome to eBeam Taking notes just got easier...giving presentations just became a snap. With the award winning eBeam® system from Luidia, Incorporated, you can turn any standard whiteboard into a digital workspace.



Attached to any standard whiteboard, the eBeam system connects your whiteboard to your computer - so you can capture, save, print, or share your whiteboard notes and drawings with anyone, anywhere, in real-time. From the conference room to the classroom, the eBeam system is the perfect solution for more effective meetings and increased teamwork. The eBeam system ships with eBeam Software. Just a few of the features of the eBeam Software are: • Recording data from your whiteboard in real-time (see eBeam Software’s meeting application). • Using your whiteboard as a virtual touch-screen (see eBeam Software’s Projection mode). • Importing images and files into the background of your whiteboard meeting that can be shared. Import image files, pdf files, Powerpoint files, Excel files, Word files, and many others (see Background Images). • Replaying, editing, and annotating images from your meetings and attach them to email messages, faxes, or just print. • Printing the entire meeting, or just the current page to a connected printer. • Saving captured meeting notes to disk in a number of different file formats. • Replaying the meeting (see Play Controls). • Sharing whiteboard meetings (with all imported background images and annotations) in real-time over your intranet or the internet. Users who are logged in can annotate the meeting remotely, while typing in comments in eBeam Software’s chat window (see Shared Meetings). • Plus many more exciting features... This help system describes the many features included in eBeam Software. For the most up to date FAQs, go to www.e-beam.com.



For the best guide through eBeam Software’s many features, begin with the section Getting Started – Read Me First.



Getting Started – Read Me First The first thing you want to do is get eBeam Software up and running and connected to the hardware. Keep in mind that there are two parts to any system using the eBeam technology: hardware and software. The hardware is set up as described in the setup instructions included in the package. This help system describes the software. There are also several different parts of eBeam Software. eBeam Software can be used to convert your whiteboard into: • A digital whiteboard with powerful meeting sharing capabilities (using eBeam Software’s meeting application); or • A virtual touchscreen which allows you to completely control your computer and all of your applications directly from the whiteboard (using a projector and eBeam Software’s Projection mode). The following links take you to sections that help you understand what the different parts of eBeam Software do, as well as help you get started using the different parts of eBeam Software. Minimum Requirements Connecting eBeam Software to the hardware What is Whiteboard mode? What is Projection mode? What is Flipchart mode? Changing the whiteboard size How does the eBeam technology work?



Minimum Requirements The requirements described here apply to the computer running the software. It’s safe to assume that if you are reading this from within the help system, your computer meets the minimum requirements for running eBeam Software. Windows • Windows®-compatible computer with Pentium® 100Mhz + processor • Windows 98, 2000, ME, XP and Windows NT 4.0 compatible (other platform users may view shared meetings via JavaTM applet through Java-enabled Internet browser) • 10 MB available hard drive space • 256 color VGA or SVGA monitor



• CD-ROM drive or Internet connection for software installation • One available serial port or USB port Macintosh Although this help system does not discuss specific Macintosh help topics, there are versions of eBeam Software available for Macintosh’s that meet the following requirements: • Power Macintosh® • Mac OS X v10.1 or higher • 10 MB available hard drive space • one available USB port



How does the eBeam technology work? While the eBeam system involves very advanced technology, it works according to a fairly simple principle, one that you've probably used yourself. During an electrical storm, if you start counting off seconds when you see a flash of lightning, the count when you hear the thunderclap can tell you how far away the storm is. This is because the light from the lightning travels at 670 million miles per hour, but the sound travels at only about 760 miles per hour. Thus, you see the lightning immediately as it flashes, but it can take several seconds for the sound of the thunder to reach you. If you count 8 seconds between the lightning and the thunder, the storm is about a mile away. The eBeam system technology works according to a similar principle. To transmit its position, the eBeam electronic pen sends out a flash of infrared light, which the eBeam system “sees.” The flash is followed by a burst of ultrasound, which the eBeam system “hears.” After it sees the flash, the eBeam system collects data from its ultrasound receivers for long enough to guarantee that it has in memory the ultrasound signal from any pen that could be on the whiteboard. The eBeam system then examines the signal and computes the exact time it takes for the ultrasound signal to reach the receivers once the flash of infrared was seen. The eBeam system is able to measure this time with an accuracy of approximately +/- 3 microseconds, producing a distance measurement accurate to +/- 1mm.



Connecting eBeam Software to the hardware After installing the software and setting up the hardware (as described in the setup instructions included in the package), you need to connect eBeam Software to the hardware.



Step



Name



Description



1



Connect



Establish a link between the hardware and software. See How to Connect.



2



Select Mode



Tell the software how you wish to use the system. The modes available are: Whiteboard mode, Flipchart mode (Windows version of eBeam Software and selected eBeam configurations only), Projection mode. See How to Select a Mode.



3



Calibrate



Tell the software what size the whiteboard is. See Calibration.



How to Connect How to Select a Mode



Calibration Selecting a port setting See Also: What is Whiteboard mode? What is Projection mode? What is Flipchart mode? Changing the whiteboard size How to Connect By default, eBeam Software automatically attempts to connect to the hardware when launched. • Are you having trouble connecting to the eBeam? See Unable to detect the hardware. • To enable/disable connect at startup, see Enable/Disable connect at startup. • If eBeam Software is not set to automatically detect the hardware, you will need to prompt eBeam Software to manually detect. To manually detect the hardware, see Manually detecting the eBeam Hardware. Go to the next step: How to Select a Mode. Unable to detect the hardware If eBeam Software is unable to detect the hardware, a Detect eBeam dialog box opens with the message: “eBeam not detected”. This dialog displays a list available ports, and which ports are available. Are you having trouble connecting to a Wireless Bluetooth eBeam? See Selecting a port setting and the eBeam System 3 Bluetooth Wireless troubleshooting section. The Detect eBeam dialog box includes the following controls:



Control Port Status list



Description Lists of all ports on your computer, and whether they are currently available. If you have specified a port to use (see eBeam Hardware Setup dialog in Selecting a port setting) only the specified port will be shown in the dialog.



Detect eBeam at application start



Instructs eBeam Software whether to continue attempting to detect the hardware when eBeam Software starts up. See Enable/Disable connect at startup.



Help



Opens eBeam Software’s help system to this topic.



Setup



Opens the eBeam Hardware Setup dialog. See Selecting a port setting.



Cancel



Cancels the detection process, but allows you to continue working with eBeam Software.



Control Retry



Description Attempts to detect the hardware again using either: your settings in the eBeam Hardware Setup dialog (see Selecting a port setting) or your selection from the port list.



To detect the hardware on a different port: 1. Select a port from the Port Status list of available ports. 2. Click the Retry button. If there are no ports listed with status available, or if eBeam Software is still unable to detect the hardware, check the following: • Make sure the hardware is set up properly, is powered up, and is connected to your computer. Refer to the setup instructions included in the box. • Check that the selected port is the correct port (see Selecting a port setting). Is the correct communication port selected? If Autodetect is selected, try to connect using “Connect To”. • Do you have a PDA attached to your computer? Shut down all programs (such as synchronization programs) currently running which might be holding open a communication port for that PDA. Go to the next step: How to Select a Mode. Enable/Disable connect at startup If you frequently use eBeam Software without the eBeam hardware, you can disable the detect eBeam hardware at startup feature To disable detect eBeam hardware at startup: 1. Open the eBeam Hardware dialog by choosing “Setup>eBeam Hardware” from the Edit menu. By default, the “Detect eBeam hardware at application start” check box is enabled. 2. To disable, uncheck the check box. To later enable detection at startup, check the check box. 3. Click OK.



Go to the previous step: What is Whiteboard mode?. Go to the next step: How to Select a Mode. See Also: Manually detecting the eBeam Hardware Unable to detect the hardware Autolaunch eBeam Software



Manually detecting the eBeam Hardware When the “Detect eBeam hardware at application start” preference is disabled, you must manually instruct eBeam Software to detect the eBeam hardware. To detect the hardware manually: • In eBeam Software’s meeting application, choose “eBeam Hardware>Detect” from the Tools menu. • In eBeam Software’s meeting application, left-click the eBeam Status icon. • Switch into an eBeam Software mode. See How to select a mode. Go to the previous step: What is Whiteboard mode? Go to the next step: How to Select a Mode. See Also: Enable/Disable connect at startup Unable to detect the hardware How to Select a Mode eBeam Software supports several different modes of operation, depending on which operating system you are using. These modes are:



Mode Whiteboard Mode



Description Captures notes, images and annotations drawn on the whiteboard. In Whiteboard mode, notes and images that you draw on the whiteboard are captured electronically, in color, in real time into the eBeam Software Meeting application. Captured data is available for storage and display both locally and remotely through your local intranet or the Internet. See also: How to select a mode. eBeam Software’s Meeting application is described in detail in eBeam Software’s meeting application.



Projection Mode (Requires a projector to be attached to the same computer that is running eBeam Software)



Turns your whiteboard into a virtual touchscreen. Projection mode allows your whiteboard to be turned into a virtual touchscreen. You connect the eBeam system and a projector to your computer. The projector displays your computer desktop onto the whiteboard and the eBeam system detects when you touch the board, allowing an electronic pen (using the plastic stylus insert) to act as a virtual mouse used to control your computer’s desktop. In virtual touchscreen mode, you can operate your computer directly from the whiteboard. You can open, work in, and close applications; draw freehand in painting and drawing applications, or you can operate eBeam Software’s Meeting application directly from the whiteboard. See also: How to select a mode. Projection mode tools are described in eBeam Software’s Projection mode.



Mode Flipchart Mode (Selected systems only; only supported in the Windows version of eBeam Software)



Description Captures notes, images and annotations drawn on the Flipchart. Flipchart mode is identical to Whiteboard mode. Some systems that use eBeam technology come with a flip chart clip. This clip attaches to a standard flip chart and is used to mount the eBeam System 3 hardware. Flipchart mode automatically sets the page size, and tells eBeam Software where the Shortcut Strip is located. See Shortcut Strip for Flipchart mode. Flipchart mode is used only with eBeam Software’s meeting application, which is described in detail in eBeam Software’s meeting application. See also: How to select a mode



Disconnect



Disconnects from the hardware, but allows you to continue using eBeam Software.



eBeam Software always opens in the mode it was in when last closed. The first time that eBeam Software is opened, it defaults to Whiteboard mode. Selecting mode at Startup To make it easier for you to specify how you plan to use eBeam Software, the first time eBeam Software launches and detects portable eBeam technology, a mode selection dialog box appears. This dialog box allows you to select which mode to use eBeam Software in (see How to Select a Mode). Possible selections are: • Capture from whiteboard (for Whiteboard mode) • Capture from Flipchart (Flipchart mode) • Use with projector (Projection mode) To select a mode at Startup, first select the mode that you wish to use eBeam Software in. Next, click the Calibration button to open the calibration wizard for to the mode you have selected. You can change the mode at any time by following the procedure How to select a mode. Go to the previous step: How to Select a Mode. Go to the next step: Calibration. See Also: How to Select a Mode Icons that represent a mode How to select a mode eBeam Software’s meeting application eBeam’s Windows system tray menu



Icons that represent a mode There are various icons indicate which mode eBeam Software is in. The following icons appear within the eBeam Software’s meeting application, as well as on your computer’s desktop:



Icon Location



Whiteboard Mode



Projection Mode



Flipchart Mode



Disconnected



Status Icon



Windows System Tray Icon



Go to the previous step: How to Select a Mode Go to the next step: Calibration See Also: How to Select a Mode How to select a mode Calibration eBeam’s Windows system tray menu How to select a mode The menus available that allow you to change the mode are: • The “Tools->eBeam Hardware” menu in eBeam Software’s meeting application. • The Status icon right-click menu in eBeam Software’s meeting application. • eBeam’s Windows system tray menu. The possible mode selections are: • Capture From Whiteboard (Whiteboard mode) • Capture From Flipchart (Flipchart mode) • Use with Projector (Projection mode) • Disable System (Disconnects from the hardware, but allows you to continue using eBeam Software)



Go to the previous step: How to Select a Mode. Go to the next step: Calibration.



See Also: How to Select a Mode Icons that represent a mode Calibration eBeam’s Windows system tray menu Calibration What is calibration? The “Image Area” of the whiteboard is the area of the whiteboard where the electronic pen strokes you make are captured into eBeam Software. The terms “Image Area” and “Capture Area” are used interchangeably. eBeam Software supports an image area from 2 to 8 feet wide, and up to 5 feet high. However, the actual image area supported is determined by the type of eBeam system you are using. Calibration defines the width and height of the image area, as well as the accurate placement of each captured point within the software window. The whiteboard area must always be calibrated to ensure that pen strokes/taps are properly detected. After calibration, for each new point that is tapped, the point’s position is determined by eBeam Software relative to the calibration points. The software knows that the point must be within the calibrated width and height range, or the point is not valid and is thrown out. eBeam Software also uses the calibrated width and height to place the point within the coordinate system when recording data into eBeam Software’s Meeting application. How to calibrate Whenever calibration is necessary, eBeam Software provides a calibration wizard to lead you through the calibration process. When connected to a portable eBeam system, the first time eBeam Software is launched, a dialog box appears that tells you that you need to calibrate and gives you the option of calibrating immediately. For any single hardware configuration, eBeam Software only needs to be calibrated once. However, each time a portable system is moved to a new location or a new position on the whiteboard, or your computer is attached to a new system, eBeam Software must be calibrated again. It is possible for each page in a meeting to have it’s own calibrated board size. This allows you to move the eBeam system to a different whiteboard, but continue to add pages to the same meeting. If there is a difference of greater than 10% in the new whiteboard size, a message dialog will inform you that the new whiteboard size will be used by new meeting pages, and ask you if you’d like to convert the current Active Page to the new whiteboard size as well. To calibrate eBeam Software: 1. Setup the hardware as described by the setup instructions included in the box. 2. Connect eBeam Software to the hardware. 3. Open the calibration wizard. If the calibration wizard doesn’t open automatically, see the



table below for instructions on how to open the appropriate wizard.



Calibrate Mode



Description



Whiteboard Mode



In eBeam Software’s meeting application, choose “eBeam Hardware> Calibrate Capture Area” from the Tools menu, or from the eBeam’s Windows system tray menu, choose “Calibrate Capture Area.”



Projection Mode



From the eBeam’s Windows system tray menu, choose “Calibrate Projection Area.”



4. Follow all on-screen directions from the calibration wizard. If the calibration is unsuccessful, try running the calibration again, making sure that you are carefully tapping points on the whiteboard, while holding the electronic pen perpendicular to the whiteboard. See Also: Stitching - Extended Capture Selecting a port setting A “port” is the connection on your computer between eBeam Software and the hardware. The default port settings are appropriate for most situations. Most often, setting the software to Autodetect the hardware is the best choice. However, if your hardware is not detected, use the following procedure to review the port setting. Important Note For Wireless Bluetooth users - If you are using the eBeam Wireless Bluetooth system, you will need to know the COM port that your Bluetooth adaptor is connected to, so that you are able to set the COM port in eBeam Software as described in this section. Please refer to your Bluetooth adaptor setup instructions for a description of where to find the COM port that has been assigned to the Bluetooth adaptor. Also, see the tutorial included on the eBeam Installation CD that describes Bluetooth setup for your operating system. To check the port setting: 1. Open the eBeam Hardware Setup dialog by: • Clicking the Setup button from the Detect eBeam dialog (which opens automatically when detection fails); or • Choosing “eBeam Hardware>Setup” from the Tools menu within eBeam Software’s meeting application; or • Choosing “System Setup” from the eBeam’s Windows system tray menu. The Autodetect radio button is enabled by default. For Windows computers, note that Autodetect can detect COM1, COM2, and USB only. 2. To specify a port, select the “Connect to” radio button, and then select a port setting from the pull-down menu. 3. Click OK. eBeam Software attempts to detect the hardware at the selected port.



If eBeam Software is unable to detect the hardware, see Unable to detect the hardware.



What is Whiteboard mode? In Whiteboard mode, notes and drawings that you draw on the whiteboard are captured electronically, in color, in real time into eBeam Software’s meeting application. The data you capture is available for storage and display both locally and remotely through your local intranet or the Internet. For details on how to put eBeam Software in Whiteboard mode, as well as the other available modes, see How to Select a Mode. The Whiteboard Capture application has many useful features, such as: • Recording data from your whiteboard in real-time (see eBeam Software’s meeting application). • Using your whiteboard as a virtual touch-screen (see eBeam Software’s Projection mode). • Importing images and files into the background of your whiteboard meeting that can be shared. Import image files, pdf files, Powerpoint files, Excel files, Word files, and many others (Background Images). • Replaying, editing, and annotating images from your meetings, and attaching them to email messages, faxes, or just printing. • Printing the entire meeting, or just the current page to a connected printer. • Saving captured meeting notes to disk in a number of different file formats. • Replaying the meeting. (For details on Rewind and replay, see Play Controls.) • Sharing whiteboard meetings (with all imported background images and annotations) in real-time over your intranet or the internet. Users who are logged in can annotate the meeting remotely, by typing comments in eBeam Software’s chat window (see Shared Meetings). The many features of the Meeting application are described in eBeam Software’s meeting application.



What is Projection mode? eBeam Software’s Projection mode turns your whiteboard into a virtual touchscreen. You can then operate your computer directly from the whiteboard. The eBeam system and the projector connect to your computer. The projector displays your computer desktop onto the whiteboard and the eBeam system detects when you touch the board, allowing your eBeam pen or eBeam’s Projection Pen to act as a virtual mouse to control your computer desktop. For details on how to put eBeam Software in Projection mode, as well as the other available modes, see How to Select a Mode. In Projection mode, you can: • Open, work in, and close applications. • Draw freehand in painting and drawing applications. • Run eBeam Software’s meeting application, including shared meetings, directly from the whiteboard, thus controlling the entire meeting directly from the whiteboard.



• Annotate over your desktop using the Projection toolbar. You can then print, save, or copy your annotations to different applications for multiple uses.



As shown in the illustration above, your computer is attached to the eBeam hardware (eBeam system 1 shown), and is also attached to the projector. The projector displays the attached computer’s desktop on the whiteboard. In Projection mode, a tap with your electronic pen on the whiteboard simulates a mouse click on your computer desktop. You can open, close, annotate, and save in an application from the whiteboard, just as you would on your own computer. Your eBeam system package includes a plastic stylus, which is an insert that fits into any electronic pen and allows you to use the electronic pen as a point and click device, instead of as a marker. The stylus is useful during presentations, when you want to select different areas of the projected desktop without leaving dry-erase marker marks on the whiteboard. eBeam Software’s Projection mode is best used as a presentation device, where you are able to open, close, and show anything you need directly from the whiteboard, instead of having to walk between you computer and whiteboard every time you want to change something. See Using Whiteboard mode and Projection mode together.



Using Whiteboard mode and Projection mode together Because eBeam Software’s Projection mode allows you to open any application on your computer, you can also open eBeam Software’s meeting application and use the Whiteboard mode and Projection mode together. Still in projection mode, open eBeam Software’s meeting application on your computer desktop. You use the Annotation Tools (from the whiteboard) to draw or annotate within the whiteboard mode application. You are also able to share or join a shared meeting (see Hosting/Sharing a meeting and Joining a meeting). A useful presentation idea is to use the Background Images feature in eBeam Software’s meeting application while in eBeam Software’s Projection mode. You can load a series of background images into eBeam Software’s meeting application, which is then displayed on the whiteboard. In addition, you can share the eBeam Software meeting, which will then display your Background Images to remote participants at the same time.



What is Flipchart mode? In Flipchart mode, notes and drawings that you draw on the flip chart are captured electronically, in color, in real time into eBeam Software’s meeting application. The data you capture is available for storage and display, both locally and remotely, through your local intranet or the Internet. For details on how to put eBeam Software in Flipchart mode, as well as the other available modes, see How to Select a Mode. Flipchart mode currently supports two standard flip chart sizes (27" x 34" and 25" x 30.5"), or a custom size that the user specifies. The flip chart clip (for supported systems) is included in the box. You do not need to calibrate when in flip chart mode. The eBeam Software knows the location of the Shortcut Strip on the flip chart clip, as well as the size of the flip chart page. The Shortcut Strip for Flipchart mode is described in Shortcut Strip for Flipchart mode. Flipchart mode is available only on selected eBeam system configurations, and supported only in the Windows version of eBeam Software.



Changing the whiteboard size You may need to change the size of the whiteboard. Sometimes the way the whiteboard is shown in eBeam Software’s meeting application is not accurate. Perhaps the size of the software window is too small, or in the software a 4' x 6' whiteboard appears to be a 4' x 4' whiteboard. In eBeam Software’s Projection mode, it is also possible that the position that you tap on the whiteboard is not the position the software thinks you have tapped. So, you may have tried to double-click “My Computer” but instead opened “Network Neightborhood'. The whiteboard size, dimensions, and accuracy can be set or changed using a process called calibration, which defines the width and height of the image area. For details on how to calibrate, see Calibration. Stitching - Extended Capture eBeam Software’s stitching (extended capture) feature allows you to double the captured area on your whiteboard by using two eBeam System 3 USB receivers. Stitching requires two eBeam System 3 USB receivers. The maximum supported image area size for stitching is twice the supported image area size for a single receiver. In most cases this is a width of 12 feet with a height of 4 feet. To enable stitching: 1. Set up the System 3 USB receivers on the whiteboard. One in the top left corner of the whiteboard, and one in the top right corner of the whiteboard. 2. Both USB cables are plugged into a USB hub that is plugged into the computer running eBeam Software.



Important - On some computers, stitching will only work if the two System 3 USB receivers are plugged into a USB hub plugged into the computer, and not the computer itself. 3. Launch eBeam Software’s meeting application. 4. Choose eBeam Hardware>Setup from the Tools Menu. 5. Select the Extended Capture checkbox. 6. Click OK. After clicking OK, the calibration wizard opens and prompts you to tap spots on the whiteboard to calibrate the system. Follow all on-screen directions. See Calibration. See Also: Calibration Unable to detect the hardware



Checking For Software Updates To check for the latest version of eBeam Software: 1. Choose “Check for Updates” from the Help menu in eBeam Software’s meeting application. The Check Application Version dialog box appears. The top area of the Check Application Version dialog box describes current software status, including version number and the date the software version was last checked. The lower area of the Check Application Version dialog box allows you to specify a schedule for periodically checking for new eBeam software. Possible schedule settings are as follows: • Every time the application is started • Every specified number of days • Never 2. Click the “Check Version Now” button to check your version and display its status in the top area of the Check Application Version dialog box. 3. Click the “Go to the Software Updates” button to link directly to www.e-beam.com and download the latest software. 4. Click OK.



eBeam System 3 Wireless: Bluetooth Configuration The Wireless Connection Settings utility is used to make changes to the eBeam wireless receiver (shown below).



See the following help topics: Hardware setup Wireless Connection Settings options Changing the Friendly Name Security Options (Discovery, Authentication, Encryption) It’s suggested that you periodically check www.e-beam.com for new FAQ’s and software updates.



Hardware setup To use the Wireless Connection Settings utility with the eBeam System 3 wireless receiver: 1. Attach the USB cable to the eBeam wireless receiver and the PC. Check the eBeam wireless receiver and verify that the green LED around the logo is glowing. This indicates that the eBeam receiver is powered. 2. Shut down eBeam Software. If eBeam Software is running on the PC, click the eBeam Icon in the Windows System



Tray and choose Exit from the pop-up menu. 3. Open the Wireless Connection Settings utility. The utility will automatically attempt to detect the eBeam System 3 wireless receiver. If the Wireless Connection Settings utility is unable to detect the eBeam System 3 Wireless receiver: • Verify that are using the eBeam System 3 Wireless receiver. The Wireless Connection Settings utility will not detect the eBeam System 3 Serial or USB only receivers. • Verify that eBeam Software is not running, and that Windows System Tray does not contain the eBeam Icon. • If you have attached the eBeam System 3 Wireless receiver through a USB hub, plug the USB cable directly into the PC and restart the Wireless Connection Settings utility. • If you have more than one eBeam system attached to the PC, disconnect all other eBeam receivers and restart the Wireless Connection Settings utility. 4. Once the Wireless Connection Settings utility has detected the eBeam Receiver, the configuration screen appears. For information about the options available in the configuration screen, see Wireless Connection Settings options.



Wireless Connection Settings options The Wireless Connection Settings configuration screen contains the following setup options:



Setting



Description



Friendly Name



The Friendly Name is the name for the eBeam System 3 receiver that is listed on PC, Mac, or handheld device when you search for Bluetooth enabled devices. For information about changing the Friendly Name, see Changing the Friendly Name.



Security



The security options allow you to determine who is allowed to use the eBeam System 3 Wireless receiver. The security options you can set include: Allow eBeam to be discovered by Bluetooth enabled devices Require Authentication (and set PIN) Use Encryption



Help



Opens the help system for the Wireless Connection Settings utility.



Apply New Settings



Applies all settings selected during this session and closes the Wireless Connection Settings utility.



Cancel



Closes the Wireless Connection Settings utility without accepting any of the changes made.



Changing the Friendly Name The Friendly Name is the name for the eBeam System 3 Wireless receiver that is listed on PC, Mac, or handheld device when you search for Bluetooth enabled devices. The eBeam System 3 Wireless receiver is shipped with a default generic Friendly Name. To change the eBeam System 3 Wireless receiver’s Friendly Name:



1. Click the Change button. The Change Friendly Name dialog box opens and displays the current Friendly Name for the receiver. 2. Type a new Friendly Name into the “New Name” text box. 3. Click OK to accept the new name, or Cancel to quit. Click the Apply New Settings button to accept these settings.



Security Options (Discovery, Authentication, Encryption) The security options allow you to determine who is allowed to use the eBeam System 3 Wireless receiver. The security options you can set include: Allow eBeam to be discovered by Bluetooth enabled devices Require Authentication (and set PIN) Use Encryption Allow eBeam to be discovered by Bluetooth enabled devices The “Allow eBeam to be “discovered” by Bluetooth(TM) enabled devices” option allows you to set whether your eBeam System 3 Wireless receiver can be detected during a search for Bluetooth enabled devices. If your eBeam System 3 Wireless receiver is not “discoverable”, other Bluetooth enabled devices will not be able to detect it. To connect to a receiver that is not “discoverable” you will need to know the Friendly Name of the receiver beforehand. If your eBeam System 3 Wireless receiver is “discoverable”, you can detect the Friendly Name of the receiver during a search for Bluetooth-enabled devices. To make the receiver discoverable, check the “Allow eBeam to be “discovered”...” checkbox. To turn off Discovery, uncheck the checkbox. Click the Apply New Settings button to accept these settings. Require Authentication (and set PIN) The “Require Authentication” option allows you to limit access to the eBeam System 3 Wireless receiver to only those people who have the PIN number for the receiver. To enable authentication: 1. Check the “Require Authentication” checkbox. 2. Click the Change button. The Change PIN dialog box opens. 3. Type a PIN into the “Enter New PIN” text box.



4. Click OK to accept the new PIN, or Cancel to quit. To disable authentication, uncheck the “Require Authentication” checkbox. Click the Apply New Settings button to accept these settings. Use Encryption Encryption is available when “Require Authentication” has been checked. To turn on encryption, check the “Use Encryption” checkbox. To turn off encryption, uncheck the checkbox. Click the Apply New Settings button to accept these settings.



eBeam Software’s meeting application eBeam Software’s meeting application can be used in both Whiteboard and Projection mode, and is used to record, save, print, annotate, and share data from the whiteboard, as well as to share ongoing meetings over your local intranet or even the internet. To open the meeting application: • Double-click the eBeam Software icon on the desktop; or • Choose “Capture from Whiteboard” from the eBeam menu in the Windows system tray.



Menus Application Toolbar



View-Change Toolbar Annotation Tools



Select one of the following topics: Menus Application Toolbar Views and the view-change buttons Setting pen colors/line thickness Annotation Tools Play Controls Background Images File Import/Export/Autosave Supported file formats for Save As/Send Autolaunch eBeam Software Shared Meetings



Status Icon



Synchronize Button



Menus eBeam Software’s meeting application menu bar:



To find help for a menu item, click on the menu name below. Each feature accessed by a menu item is described in detail, along with links leading to more detailed information. File Menu Edit Menu View Menu Page Menu Meetings Menu Tools Menu Windows Menu Help Menu File Menu The File menu options are described below:



Menu Selection



Description



New



Creates a new meeting.



Open



Opens a standard Open File dialog box. Navigate to the *.wbd file, and selects that file to open.



Close



Closes the selected meeting.



Save



Saves the selected meeting. If this is the first time the meeting has been saved, the standard Save As dialog box opens allowing you to enter a meeting name and select the folder location. If the file has been saved before, then it is saved again under the existing name.



Save As



Opens the standard Save As dialog box, allowing you to enter a meeting name and select the folder location. For supported formats for saving a file, see Supported file formats for Save As/Send.



Import PDA Meetings



Opens the Import PDA Meeting dialog box. See Import PDA Meetings.



Print



Opens the standard Print dialog box.



Print Page



Prints the selected Page only. See also: Application Toolbar.



Print Setup



Opens the standard Print Setup dialog box.



Menu Selection Page Setup



Description Opens the Page Setup dialog box. The Page Setup dialog box allows you to choose header and footer information for the printed page, as well as whether to place a border on the printed page. Available information includes: page numbering information, the meeting name, the date and time in various formats, and the eBeam logo.



Send



Opens the Send dialog box, which allows you to send the selected meeting (in various formats) to selected recipients using your email client. See Send.



Exit



Closes the Meeting application.



Edit Menu The Edit menu options are described below:



Menu Selection



Description



Undo



Erases the previous whiteboard stroke or annotation. It is possible to undo until the page is blank.



Redo



Redoes the last undone whiteboard stroke/annotation. This option is available when Undo was previously clicked. In the case of multiple undos, it is possible to redo back to the final whiteboard stroke/annotation in the page. Redo is disabled once the next new whiteboard stroke/annotation occurs.



Copy



Copies the contents of the rectangle. The selector tool (located in Annotation Tools) allows you to draw a selection rectangle, then copy and paste the contents of the rectangle. Choose Copy from the Edit Menu to copy a selected object to the Clipboard. Data copied into the clipboard can be pasted into other applications. It is not possible to paste copied data into another Meeting page. However, copied data is contained in the clipboard, and can be included in an eBeam meeting page as a background image. See Background Images.



Delete Text



Deletes the entire selected text box. Available only when a text box is selected. See the Text Tool description in Annotation Tools.



Select All



Selects the entire page. Used to copy the full page. See the description of Edit>Copy above. Available only in the full Page View. See Views and the view-change buttons.



Setup



Opens the Setup dialog box. The Setup dialog box contains the following four tabs: • eBeam Hardware. See description of the eBeam Hardware tab in eBeam Hardware Setup. • Proxy Server. See Proxy Server Setup. • Preferences. See description of Preferences tab in Preferences – Setup. • Image Size. See Image Size. • Web Tour. See Web Tour Setup.



eBeam Hardware Setup The eBeam Hardware tab in the Setup dialog box allows you to set: • Whether or not to automatically detect the hardware at software startup. See Enable/Disable connect at startup. Preferences – Setup The Preferences tab in the Setup dialog box allows you to set: • File autosave/backup settings. See Autosave. • Application toolbar preferences. See eBeam Software Toolbar Preferences. • Smooth lines (anti-aliasing). Smooth lines can be turned on/off by checking/unchecking the “Smooth Lines (Antialiasing)” checkbox. • PowerPoint Presentation Import. When importing PowerPoint slides that contain high quality images into eBeam Software, PowerPoint typically decreases the file size by converting the images into a lower quality image format. This means that the images shown in eBeam Software are not as sharp or clear as the original PowerPoint slides. Checking “Use original image quality” causes the high image quality of the original PowerPoint slide to be maintained as the file is imported into eBeam Software. However, checking this option also results in higher PC memory consumption and increases the time required to save, share, and join meetings. See Loading a PowerPoint Presentation as a background image for more information on importing PowerPoint presentations. View Menu The View menu options are described below:



Menu Selection



Description



Toolbar



Shows/hides the Tools (Annotation Tools) and Play Controls toolbars. Also allows you to choose “At top” or “At bottom” for locating the toolbars at either the top or the bottom of the Meeting application.



Zoom



Magnifies/Zooms the current page. The following settings are available for the currently displayed page in the Page View: Zoom In, Zoom Out, or 100%. See also: the Zoom tool in Annotation Tools.



Full Screen



Maximizes the current view to full screen size, hiding the menu bar, and maximizing the application if necessary. Choose Full Screen again to go back to normal mode. See also: Application Toolbar.



Thumbnails



Switches to the Thumbnails View. See Views and the view-change buttons.



Participants



Switches to the Participants/Chat View. See Views and the view-change buttons.



Web Tour



Switches to the Web Tour View. See Web Tour.



Pages



Switches to the Page View. See Views and the view-change buttons.



Float Thumbnails View



Separates the Thumbnails View and floats it as its own window.



Menu Selection



Description



Float Participants View



Separates the Participants/Chat View and floats it as its own window.



Float Web View



Separates the Web View and floats it as its own window.



Page Menu The Page menu options are described below:



Menu Selection New Page



Description Creates a new page in the current meeting. If the current meeting also contains the Active Page (page currently receiving data from the eBeam system), the new page becomes the Active Page. If a different meeting contains the Active Page, the new page does not receive data from the eBeam hardware. For details on how to set a meeting to receive data from the eBeam system when multiple meetings are open, see the “Select eBeam Meeting” description in Tools Menu.



Clear Page



Clears everything from the selected page.



Duplicate Page



Duplicates the selected page, and inserts the new page following the duplicated page. If the current meeting also contains the Active Page and the page to be duplicated is the Active Page, the duplicated page becomes the Active Page. For details on how to set a meeting to receive data from the eBeam system when multiple meetings are open, see the “Select eBeam Meeting” description in Tools Menu.



Delete Page



Deletes the selected page.



Delete All



Deletes all pages in the selected meeting.



Insert Page Before Current



Inserts a new page before the selected page.



Make Current Page Active



Sets the selected page as the Active Page (page currently receiving data from the eBeam system).



Next Page



Switches to the next page in the meeting. This option is available only when the last page in the meeting is not currently displayed.



Previous Page



Switches to the previous page in the meeting. This option available only when the first page in the meeting is not currently displayed.



Go To Page



Opens the Go To Page dialog box. To select a particular page, type the page number and Click OK.



Background Image



Opens the Background Images dialog box. See Background Images.



Meetings Menu The Meetings menu options are described below:



Menu Selection Share Meeting



Description Opens the Share Meetings dialog box. See Hosting/Sharing a meeting. See also: Sending an email invitation to a meeting. This option requires that eBeam Software be connected to the eBeam receiver before the Share Meeting dialog box will launch. See Connecting eBeam Software to the hardware.



Join Meeting



Opens the Join Meeting dialog box. See Joining a meeting.



Send Invitation



Opens your default email client, allowing you to select recipients from your own address book. See Sending an email invitation to a meeting. This option requires that a shared meeting be in session. See Shared Meetings.



Archive Meeting



Choosing Archive Meeting opens a dialog box that allows you to archive your meeting on eBeam’s new meeting server. See Archiving eBeam Meetings.



Retrieve Meeting



Choosing Retrieve Meeting opens a dialog box that allows you to retrieve a meeting from eBeam’s new meeting server. See Retrieving Archived eBeam Meetings.



Participants



• Information. Displays a dialog box showing a summary of information about the selected participant. Some information includes: name, role (coordinator or participant), interactive? (allowed to annotate?), time connected, IP address, domain name, and any notes entered into the notes field in the Share Meeting or Join Meeting dialog boxes. • Set View Only. Mutes the selected meeting participant. The participant is able to view everything that occurs in the meeting but is not able to annotate the meeting. The participant can still chat in the Participants View. See also: Views and the view-change buttons, and Using eBeam Chat. Only available if you are the meeting host. See Hosting/Sharing a meeting. • Exclude Participants. Disconnects the selected participant from the shared meeting. This option is available only if you are the meeting host. See Hosting/Sharing a meeting. • Set View Only - All. Mutes all meeting participants. The participants are able to view everything that occurs in the meeting but are not able to annotate the meeting. The participant can still chat in the Participants View. See also: Views and the view-change buttons, and Using eBeam Chat. This option is only available if you are the meeting host. See Hosting/Sharing a meeting.



Synchronize Participants



Forces all participants to view the same page as the host. This option is only available to the meet host. All meeting participants are forced to view the page that the host is viewing. When the host switches pages, all participants automatically switch at the same time. See Hosting/Sharing a meeting. The synchronize button is available on the View control bar. See Views and the view-change buttons.



See Also: Views and the view-change buttons Annotation Tools Hosting/Sharing a meeting



Sending an email invitation to a meeting Joining a meeting What can the meeting coordinator do? What can a meeting participant do? Using eBeam Chat



Tools Menu The Tools menu options are described below:



Menu Selection eBeam Hardware



Description • Detect. Attempts to detect the eBeam Hardware. See also Connecting eBeam Software to the hardware. • Setup. Opens the eBeam Hardware Setup dialog box. See Selecting a port setting. • Calibrate Capture Area. Opens the calibration wizard for whiteboard mode. This option is disabled in projection mode. See Calibration. • Check for Firmware Upgrades. The eBeam group is continually working to improve the eBeam system. Periodically, firmware specifically for the eBeam hardware is released onto eBeam’s website. This options allows you to check to see if firmware has been released recently, and if you wish, to download and install the new firmware. • Bluetooth Configuration. Opens the Bluetooth Configuration dialog, which is used specifically for the eBeam System 3 Wireless system. This option will not work with other systems. Note: The eBeam System 3 Wireless receiver must be connected to the computer via USB cable for the configuration program to communicate with it. • Capture from Whiteboard. Switches eBeam Software to Whiteboard Mode. See How to Select a Mode. • Capture from Flipchart. Switches eBeam Software to Flipchart mode. Available on selected eBeam system configurations only. See How to Select a Mode. • Use with Projector. Switch eBeam Software to Projection Mode. See How to Select a Mode. • Disable System. Disconnects eBeam Software from the hardware. Frees the communication port.



Shortcut Strip



Allows you issue various page commands directly from the whiteboard or flipchart, without having to go to your computer. For a detailed description, see Using the Shortcut Strip.



Sleeve Settings



Opens the Sleeve Settings dialog box. See Setting pen colors/line thickness.



Select eBeam Meeting



Opens the Select eBeam Meeting dialog box that allows you to select which open eBeam meeting is currently receiving input from the whiteboard. Select an open meeting from the pull-down list, and then select OK. The meeting must be open for its name to appear in the Select eBeam Meeting dialog box.



Microsoft NetMeeting



Opens Microsoft NetMeeting to use for online meetings. Requires that NetMeeting has previously been installed on your Windows computer. See Microsoft NetMeeting.



Windows Menu The Windows menu options are described below:



Menu Selection Cascade



Description Cascades all open meeting windows.



Menu Selection



Description



Tile



Horizontally or vertically tiles all open meeting windows.



Meeting List



Displays the names of all open meetings. Selecting a meeting name brings that meeting to the forefront.



Help Menu The Help menu options are described below:



Menu Selection



Description



Contents



Opens the online help system.



Online Support



Opens your web browser and loads the www.e-beam.com support page.



Registration



Opens your web browser and loads the www.e-beam.com registration page.



Common Questions



Opens your web browser and loads the www.e-beam.com FAQs page.



Software Update



Opens your web browser and loads the www.e-beam.com downloads page.



Check for Updates



Opens the Check Application Version dialog box. See Checking For Software Updates.



System Diagnostics



This option is used only by technical support.



System Information



Opens the standard System Information dialog box.



About eBeam Software



Displays the About dialog box for eBeam Software. To close, click anywhere in the About dialog box.



Check www.e-beam.com for the updated FAQ, installation notes and software updates.



Application Toolbar eBeam Software’s meeting application toolbar is located at the top of the meeting application window, under the menu bar. See also: eBeam Software Toolbar Preferences.



Toolbar Button New



Description Creates a new page in the current meeting. Also available in the Page Menu. If the current meeting also contains the Active Page (page currently receiving data from the eBeam system), then the new page becomes the Active Page. For details on how to set a meeting to receive data from the eBeam system when multiple meetings are open, see the “Select eBeam Meeting” description in Tools Menu.



Toolbar Button Duplicate



Description Duplicates the selected page, and inserts the new page following the duplicated page. Also available in the Page Menu. If the current meeting also contains the Active Page and the page to be duplicated is the Active Page, then the duplicated page becomes the Active Page. For details on how to set a meeting to receive data from the eBeam system when multiple meetings are open, see the “Select eBeam Meeting” description under Tools Menu.



Delete



Deletes the selected page. Also available in the Page Menu.



Print



Prints the selected page. Also available in the Page Menu.



Full Screen



Maximizes the current view to full screen size, hiding the menu bar, and maximizing the Meeting application, if necessary. To go back to normal mode, click Full Screen again. Also available in the View Menu.



Share Meeting



Opens the Share Meeting dialog box. See Hosting/Sharing a meeting. See also: Sending an email invitation to a meeting. Also available in the Meetings Menu. This option requires that the eBeam Software be connected to the eBeam hardware before the Share Meeting dialog box will launch.



Join Meeting



Opens the Join Meeting dialog box. See Joining a meeting. Also available in the Meetings Menu.



View Only



Mutes the selected meeting participant. The participant is able to view everything that occurs in the meeting but is not able to annotate the meeting. The participant can still chat in the Participants View. This option is shown only when the Participants/Chat View is displayed. See also: Views and the view-change buttons, and Using eBeam Chat. Also available in the Meetings Menu. Only available if you are the meeting host. See Hosting/Sharing a meeting.



View Only – All



Mutes all meeting participants. The participants are able to view everything that occurs in the meeting, but are not able to annotate the meeting. The participants can still chat in the Participants View. This option is shown only when the Participants/Chat View is displayed. See also: Views and the view-change buttons, and Using eBeam Chat. Also available in the Meetings Menu. This option is only available if you are the meeting host. See Hosting/ Sharing a meeting.



Exclude



Disconnects selected participant from the shared meeting.This option is shown only when the Participants/Chat View is displayed. See also: Views and the view-change buttons, and Using eBeam Chat. Also available in the Meetings Menu. This option is only available if you are the meeting host. See Hosting/ Sharing a meeting.



eBeam Software Toolbar Preferences You can specify whether to show only icons, only text, or both icons and text on the toolbar. To specify your toolbar preferences: 1. Choose “Setup” from the Edit Menu. The Setup dialog box opens.



2. Click the “Preferences” tab. Under the “Preferences” tab, there are checkboxes for both icons and text. A checkmark causes the icons or text to be shown. 3. Select icons and/or text. 4. Click OK.



Views and the view-change buttons The view area is the center of eBeam Software’s Meeting application window. eBeam Software’s Meeting application has several views: • Page Display View: The Page Display View displays a single meeting page at one time, allowing you to see each new whiteboard drawing as it is drawn. • Participants View: The Participants View shows you who is logged into a shared meetings, and allows the logged in participants to chat online. See also: Using eBeam Chat. • Thumbnails View: The Thumbnails View displays thumbnails of all pages in the meeting. Use the scroll bar on the right to scroll through all available thumbnails. Selecting a thumbnail opens that page in the Page Display View. • Web View: The Web View allows access to web pages, and allows the meeting host to lead a Web Tour. The View-Change toolbar (shown below) is used to navigate between the different views. Switch To Participants View Button



Switch To Web View Button



Switch To Thumbnails View Button



Active Page



Page Select Scrollbar



Currently Displayed Page



Mouse Rollover Quick Page Preview



Synchronize Button



Previous Page/ Next Page



Each control in the View-Change toolbar is described below:



Control



Description



Switch To Participants View Button



Switches to the Participants View. See Using eBeam Chat.



Switch to Thumbnails View Button



Switches to the Thumbnails View.



Switch to Web View Button



Switches to the Web View. See Web Tour.



Page Select Scrollbar



Displays a page button for all pages contained in the meeting. The button for the currently displayed page in the Page View is larger and overlaps the other page buttons (see example for page 1 in the image above). If the number of pages exceeds the amount of space in the scroll bar, the scrolling arrows become active. See also: Reordering meeting pages. Rolling your mouse pointer over a page button causes a thumbnail of that page to pop up (see example for page 5 in the image above). This allows you to see the page without displaying the page in the Page View. Moving the mouse pointer away from the page button closes the pop-up.



Control



Description



Currently Displayed Page



Shows the currently displayed page in the Page Display View. When a page is displayed in the Page Display View, the corresponding button in the Page Select Scrollbar is larger than the other buttons. See also: Reordering meeting pages.



Mouse Rollover Quick Page Preview



Opens thumbnail. Rolling your mouse over a page on the Page Select Scrollbar and then holding it for a second causes a thumbnail of the page to pop up. Moving the mouse away from the Page Select Scrollbar closes the thumbnail.



Active Page



Shows the Active Page icon that is currently receiving whiteboard data from the hardware. See also: Make Current Page Active from the Page Menu, and Reordering meeting pages.



Previous Page/ Next Page Buttons



Displays the previous or next page in the meeting. Previous Page button enabled only if the currently displayed page is not the first page in the meeting. The Next Page button is enabled only if the currently displayed page is not the last page in the meeting.



Synchronize Button



Causes all participants to be forced to view the same page as the meeting host. For details, see the Synchronize feature in What can the meeting coordinator do?



Reordering meeting pages You can reorder or move meeting pages on the Page Select scrollbar by using your mouse to drag a page to a new location. As you drag the page, and indicator arrow appears on the scrollbar that lets you know where the page will be inserted. Once the page has been moved, all pages are immediately renumbered. If you have moved a page to a higher page number location, all other pages will shift down. If you move a page to a lower page number location, all other pages will shift up. You cannot undo a page move.



See Also: Using eBeam Chat What can the meeting coordinator do? What can a meeting participant do? Web Tour



Setting pen colors/line thickness The Sleeve Settings dialog box defines how strokes made on the whiteboard with an eBeam marker are represented in eBeam Software’s Meeting application window. eBeam Software’s Meeting application has default screen colors and line thickness already defined; however, you can modify these default colors and line thicknesses to suit your needs. To set pen colors and line thickness:



1. Choose “Sleeve Settings” from the Tools Menu. 2. Select the desired line thickness for each electronic pen. Each electronic pen has a corresponding picture and set of line thicknesses in the Sleeve Settings dialog box. NOTE: On-screen line weights may appear thicker or thinner than the actual marker strokes on the whiteboard. 3. Select the desired screen colors for each electronic pen. The Color dialog box appears. Your screen colors can differ from the dry-erase marker and the ring on the electronic pen, if desired. You can create your own colors or use the basic colors provided. In the Sleeve Settings dialog box, the screen color bar changes to reflect the color you selected for each sleeve color. To return the sleeve colors to the default setting, click the Restore Defaults button. 4. Click OK to save your color choices. Changing width/color of previously recorded strokes To change width/color of previously recorded strokes: 1. Choose “Sleeve Settings” from the Tools Menu. 2. Select the desired new line width/new color. 3. For both the line width, and line color, select “Apply to Previous Strokes”, and specify if you would like this to apply to the current page only or all pages in the meeting. 4. Click OK to apply the width change. Changes to the color or line width of pen strokes cannot be undone.



Annotation Tools The Annotation Toolbar is a palette of tools that allow the user to annotate/draw on the displayed meeting page using the computer’s mouse and keyboard. Some uses for the Annotation tools include: • Highlighting an important item on the whiteboard. • Adding text notes to a page that elaborate on the meaning of the whiteboard drawing. • Highlighting items that remote participants should pay close attention to during a shared meeting. See Using Annotation Tools during a Shared Meeting. • Creating meeting pages, when using eBeam Software’s Meeting application in Projection mode. See Using whiteboard mode and projection mode together).



The Annotation toolbar is displayed below along with a table of descriptions (from left to right) of each tool: Marker



Eraser



Highlighter



Tool



Text



Zoom



Selector



Pointer



Description



Marker



The Marker tool allows you to annotate the displayed page freehand in one of four solid colors. The color can be selected from the palette that appears when the Marker tool is selected.



Highlighter



The Highlighter tool allows you to annotate the displayed page freehand in one of four transparent colors. The color can be selected from the palette that appears when the Highlighter tool is selected.



Eraser



The Eraser tool allows you to erase (from the displayed page) both the marker strokes drawn on the whiteboard and the annotation marks made with the Annotation tools. The eraser size can be selected from the palette that appears when the Eraser tool is selected.



Zoom



The Zoom tool allows you to adjust the viewing size of the displayed page. The range of zoom values are 100-2000%. Holding down the Shift key reverses the zoom direction. A zoom value can also be selected from the pull-down list that appears when the Zoom tool is selected.



Text



The Text tool allows you to add text annotations to a meeting in any size, font, and color available on your computer. The size, font, and color may be selected from the palette that appears when the Text tool is selected.



Pointer



The Pointer tool allows each participant in a meeting to point to data anywhere within the meeting window. Each participant’s pointer is displayed in a different color. The Pointer tool is only enabled during a shared meeting. The pointer direction (right, left, up, down) can be selected from the palette that appears when the Pointer tool is selected. You can also hide the pointer by clicking the “Hide Pointer” button from the palette that appears when the Pointer tool is selected.



Selector



The Selector tool allows you to draw a selection rectangle and copy the selection. The selected rectangle can then be pasted into another application.



Using Annotation Tools during a Shared Meeting During an online meeting (see Shared Meetings), connected participants can create annotations to the meeting which are visible to all other participants in the meeting. If the meeting is not synchronized by the meeting host, and the participant has not been set to View-Only, the participant may annotate on any page in the meeting. See What can the meeting coordinator do? and What can a meeting participant do? If the meeting is synchronized by the meeting host, the participant is restricted to annotating only on the displayed page.



If the participant has been set to View-Only by the meeting host, the participant cannot annotate the meeting. The Zoom tool is always available, but zooming in/out of a page is not visible to other participants.



Play Controls The Play Controls toolbar allows you to replay the meeting like a movie. The meeting can then be played forward, line by line, at varying speeds. Playback can be restricted to either the current page, or set to play all pages. Some uses for the Play Controls: • Viewing the meeting chain of events. • Branching, which returns the meeting to a specific point and then duplicates the page. The duplicated page will create a new page with meeting data to the selected point, allowing you to explore a different idea without manually duplicating previous work, and keeping the original page intact. The Play Controls toolbar is displayed below along with a table of descriptions (from left to right) of each control on the toolbar: Jump to beginning



Play



Drag control slider



Tool



All Pages



Jump to end



Play speed



Loop



Description



Jump to beginning



Jumps to the very beginning of the meeting, which is always the original blank page.



Drag control slider



Allows you to step through the meeting forward or reverse by clicking on the drag line, or to immediately jump to a specific point in the meeting by dragging the drag bar to a location on the drag line.



Play



Replays the meeting from beginning to end, beginning with a blank screen. While playing, the Play button changes to a Stop button, allowing you to stop the playback. See Play Speed.



Jump to end



Jumps to the end of the meeting, restoring all whiteboard strokes and annotations.



All Pages



Sets the number of pages played by Play Controls. If “All Pages” is checked, clicking “Play” causes the entire meeting is played back. If “All Pages” is not checked, only the currently displayed page is played back.



Loop



Replays the meeting from beginning to end, beginning with a blank screen. Once the end of the meeting is reached, begins to replay from the beginning. Runs continuously. While playing, the Play button changes to a Stop button, allowing you to stop the playback.



Play Speed



Sets the speed at which the meeting is played. The slowest speed is 0.5x; the fastest speed is 8.0x.



Background Images You can import a file, screen capture, or data from the clipboard as a background image on the page currently displayed in Page View. The background image remains in the background of the currently displayed page. Any markings, including typed text, whiteboard marker strokes, or erasures, remain visible in front of the image. During a shared meeting, background images are displayed to all participants. To load/remove a background Image: 1. Navigate to the Meeting page you wish to load the background image into. 2. Choose “Background Image” from the Page Menu, or drag-and-drop the file onto the page. This opens the Background Image dialog box which contains the following options: Button Load Image



Description Opens the standard Open dialog box. To load an image, navigate to and select the file you want to load into the page background, and then click OK. The file to be imported is displayed in the preview window of the Background Image dialog box. To add, click OK. See Supported File Formats for Background Images, Loading an Excel Spreadsheet as a background image, and Loading a PowerPoint Presentation as a background image.



Load From Clipboard



Loads data from the computer’s clipboard as the background image. If there is no data in the computer’s clipboard, this button is disabled. The data from the system’s clipboard is displayed in the preview window of the Background Image dialog box. Click OK to add. In general, capturing a screen or copying data within an application will load data into the system’s clipboard.



Capture Screen



Creates a capture rectangle by holding down the left mouse button and dragging the pointer across the screen until the rectangular outline encloses the area of the screen you wish to capture. Clicking Capture Screen causes eBeam Software’s meeting application to minimize. Release the mouse button, and the captured area is displayed in the preview window of the Background Image dialog box. Click OK to add the captured area as a background image.



Remove Image



Removes the background image from the page. Any whiteboard strokes or annotations will remain on the page.



Keep Aspect Ratio



Sets the proportions of the background image. If the “Keep Aspect Ratio” checkbox is checked, the image is loaded into the background in proportion to the original. If the “Aspect Ratio” checkbox is not checked, the image is stretched to fill the page when loaded into the background.



Load Image, Load From Clipboard, and Capture Screen load into the displayed page, rather than beginning a new page. When using these features, make sure that you are not overwriting a previously loaded background image.



See Also: Supported File Formats for Background Images



Loading an Excel Spreadsheet as a background image Loading a PowerPoint Presentation as a background image Supported File Formats for Background Images Listed below are supported file types. • Bitmap (*.bmp) • Graphic Files (*.gif, *.jpg, *.ico, *.emf, *.wmf) • Excel Spreadsheets (*.xls) • PowerPoint Presentations (*.ppt) • Word Document (*.doc, *.rtf) If you attempt to load a file type that is not supported the page will display a large icon associated with file type, and the filename, but will not attempt to load that file into the page. Loading an Excel Spreadsheet as a background image To load an Excel Spreadsheet as a background image: 1. Choose “Background Image” from the Page Menu, and use the “Load Image” button to load the Excel (*.xls) file. For details on how to use the “Load Image” button, see Background Images. You can also drag-and-drop an Excel (*.xls) file onto the page to open it as a background image. NOTE: It is not possible to load an Excel spreadsheet that contains a graph. 2. If there is more than one worksheet in the *.xls file, the Excel Spreadsheet Import dialog box opens. Specify to either: • Load the data from one sheet only, or • Load data from many sheets and use them for new pages. 3. To load data from one sheet only, specify the sheet and the range of cells to be used. You can preview the image by clicking the “Show Preview” button. 4. To load data from many sheets, specify the sheets to be used. You can also choose to have the first loaded image placed on the last existing meeting page. There is a limit to the number of rows and columns you can import from a sheet. The data range you can select depends on whether you are loading data from one sheet or from many sheets, and is also dependent upon your computer. Loading a PowerPoint Presentation as a background image To load an PowerPoint Presentation as a background image: 1. Choose “Background Image” from the Page Menu, and use the “Load Image” button to locate the PowerPoint (*.ppt) file. For details on how to use the “Load Image” button, see Background Images.



You can also drag-and-drop a PowerPoint (*.ppt) file onto the page to open it as a background image. The Multiple Page Background dialog box appears, with a description of the PowerPoint presentation size and a list of options. 2. Decide how much of the presentation you want to include as a background image to the meeting by choosing one of the following: • Load many images and use them for new pages—loads slides that fall within the range you specify. • Load one image only and use it for the current page—loads one image that you specify by scrolling to the appropriate slide number. 3. Click OK. Image Quality for PowerPoint Presentations When importing PowerPoint slides that contain high quality images into eBeam Software, PowerPoint typically decreases the file size by converting the images into a lower quality image format. This means that the images shown in eBeam Software are not as sharp or clear as the original PowerPoint slides. You can specify that the high image quality of the original PowerPoint slide is to be maintained as the file is imported into eBeam Software. To do this: 1. Choose Setup from the Edit menu. 2. Click the Preferences tab. 3. Check or uncheck the “Use original image quality” checkbox found under “PowerPoint Presentation Import”. Checking “Import the best quality images” causes the high image quality of the original PowerPoint slide to be maintained as the file is imported into eBeam Software. However, checking this option also results in higher PC memory consumption and increases the time required to save, share, and join meetings.



File Import/Export/Autosave Export to File Format Import PDA Meetings Send Image Size Autosave Supported file formats for Save As/Send



Export to File Format To save an eBeam file as a different file format: 1. Choose “Save As” from the File Menu. The “Save As” dialog box appears. 2. Select the file format from the Save As Type pull-down list. If there are any special page options available for the selected format, they are displayed directly beneath the Save As Type pull-down immediately after the format has been selected. 3. Click Save. For supported file formats, see Supported file formats for Save As/Send. Import PDA Meetings Import PDA Meetings is used to import an eBeam database into your computer from a Palm handheld. eBeam software for the Palm(TM) handheld can be found at www.e-beam.com. To import a PDA database: 1. Choose “Import PDA Meetings” from the File Menu. 2. Select the user name. Because some PDA software allows for several users to be set up on one computer, you must select which user directory to search. 3. If you had previously chosen to install the PDA directory in a non-standard directory, you must change the directory location by clicking the “Browse” button. Select the appropriate directory. Once the directory is located, all eBeam meeting files contained in the PDA database appear. 4. Select the files you want to import from the list. 5. Click OK. Send You can send an eBeam Software Meeting file as an e-mail attachment via any MAPI-compliant mail system, such as Microsoft Exchange. This option is available when Microsoft Exchange is installed as your Mail system. 1. Choose “Send” from the File Menu. The Send dialog box opens. 2. Select the file format and page range in the Send dialog box Supported file formats are listed in Supported file formats for Save As/Send. 3. Click OK.



eBeam opens an untitled e-mail message in your MAPI-compliant mail program with your file as an attachment. Use your address book to fill in names of the recipients, and send the email as you normally would. You can save an eBeam meeting in any file format (except HTM) that is suitable for an e-mail attachment. HTM is not available because a folder (containing meeting pages) is created, and eBeam Software cannot attach a folder to an Exchange message. See Also: Supported file formats for Save As/Send Image Size The “Image Size” tab (Edit Menu>Setup dialog box) allows you to modify meeting files created using the File Menu>Save As and File>Send menu options. See File Menu and Send. When the size of the calibrated whiteboard changes, the size of the meeting page image also changes. If the whiteboard has been recalibrated and the viewable area expanded, the image expands to work within the new height and width ratio, as long as the “Keep Aspect Ratio” checkbox is checked. For a table of supported export formats, see Supported file formats for Save As/Send. To modify the image quality: 1. Choose Setup from the Edit Menu. 2. Click the “Image Size” tab. 3. Enter the width and/or height of the image, either by scrolling to the desired value or entering a number. 4. Select whether to keep the width and height ratio by checking or clearing the “Keep Aspect Ratio” check box. The “Keep Aspect Ratio” check box is checked by default. Note that when “Keep Aspect Ratio” is checked, a change made to either the height or the width automatically changes the other dimension. This ratio reflects the ratio calibrated for the whiteboard. 5. To save modifications, click OK. 6. To restore the default settings, click the “Restore Default” button. If the whiteboard image appears stretched in either direction, make sure the “Keep Aspect Ratio” check box had been checked.



Autosave The Autosave feature ensures that you don’t lose your meeting data if the power goes out, your laptop runs out of battery life, etc. The default Autosave setting is set to backup your file every 10 minutes. To adjust the autosave setting:



1. Choose Setup from the Edit Menu. 2. Click the Preferences tab. 3. Enable/or disable autosave by checking/unchecking the “Save Recovery File every:” checkbox. 4. Choose how often your meeting data will be saved by changing the number of minutes. Supported file formats for Save As/Send The following is a list of file formats supported for saving a meeting or using the Send to distribute a meeting. • eBeam Software File (*.wbd) • PDF (*.PDF) • Vector PDF (*.PDF) • HTML (*.HTM) (not available for Send) • 24-bit Bitmap (*.BMP) • 256 color Bitmap (*.BMP) • Monochrome Bitmap (*.BMP) • EPS monochrome (*.EPS) • JPEG (*.JPG) • TIFF (*.TIF) • Metafile (*.emf) • PowerPoint Presentation (*.ppt) • PowerPoint Show (*.pps) See Also: Send Image Size File Menu



Autolaunch eBeam Software Autolaunch is used with eBeam Software’s meeting application in Whiteboard mode. If you have been working in Whiteboard mode, and you shut down eBeam Software’s meeting application, the application window will close, but the eBeam system will continue to “listen” for pen taps/strokes on the whiteboard. If the eBeam System detects that you have written on the whiteboard, eBeam Software’s meeting application will open and begin capturing data immediately. If you do not wish to use Autolaunch, click Disable System or Exit on the Windows taskbar menu after closing eBeam Software’s meeting application. Autolaunch is not available from Projection mode.



See Also: Connecting eBeam Software to the hardware How to Select a Mode



Shared Meetings What is an eBeam meeting? An eBeam meeting is a collection of notes and annotations which may consist of a single page or multiple pages. In either case, all pages contained in one eBeam Software’s meeting application (*.wbd) file. A single meeting may have one or more participants who are sitting in one room using eBeam to capture notes and diagrams. A single meeting may also have participants who are located in other locations, such as another floor in your building, another state, or even another country. What is a shared meeting? A shared eBeam meeting is a meeting that is broadcast over your local intranet or over the world-wide web (internet). At one location, the meeting coordinator/host uses the eBeam system (software and hardware) to broadcast the meeting over the network (see Hosting/Sharing a meeting). Remote participants use eBeam Software’s meeting application or a web browser to log into the meeting (see Joining a meeting). The meeting is broadcast in real time, which means that remote participants see the lines as they are drawn. If the meeting coordinator allows participants this option, participants can annotate meeting pages, highlighting important points, and adding notes that can be seen by all other participants as well as the coordinator. To allow remote participants (located outside of your local network firewall) to access your shared meeting, the meeting server must be located on the Internet. eBeam currently hosts a meeting server that may be used by any eBeam system user.



Meeting Topics: Hosting/Sharing a meeting Hosting Multiple Meetings Sending an email invitation to a meeting Joining a meeting Accepting an email invitation Archiving eBeam Meetings Retrieving Archived eBeam Meetings



What can the meeting coordinator do? What can a meeting participant do? Using eBeam Chat Web Tour Microsoft NetMeeting



Hosting/Sharing a meeting The following explains how to host/share a meeting over your local intranet or the internet. If you share the meeting on your local intranet, only people within your intranet can access the meeting. If you share your meeting over the internet (using the eBeam server), participants from any internet location can access your meeting. To share a meeting, you must be connected to the eBeam hardware. Also, if there is any possibility that your network uses a proxy server, see Proxy Server Setup. To host a shared meeting: 1. Choose “Share Meeting” from the Meetings Menu or the “Share Meeting” button from the Application Toolbar. The Share Meeting dialog box opens. 2. Under “Meeting Information”, enter: • Meeting Name. The meeting name is the name shown in the Join Meeting dialog box. The meeting name is saved as the default name for subsequent meetings, until you change it. The meeting name can be up to 20 characters. • My Name. The name displayed in the Participants/Chat View. See Using eBeam Chat. • Notes. Any notes/comment you would like to include. • Publish Meeting Name. Select “Publish Meeting Name” if you want the name of the meeting to be visible to network users who are attempting to join a meeting using either the Join Meeting (see Joining a meeting) dialog box, or the Meetings web page located at www.e-beam.com. If you do not publish the name, guests will need to know the full meeting name beforehand and manually type it into the Join Meeting dialog box. • Password/Confirm/Use Password. If a password is required, check the “Use Password” checkbox and type the same password into both the Password and Confirm text boxes. The password must be at least 6 characters, and can be up to 20 characters. • Send Meeting Invitation. Meeting invitations are email invitations that are sent out using your standard mail client. If “Send Meeting Invitation” is checked, the Send Invitation dialog box opens once you click the Share button. See also Sending an email invitation to a meeting. • Archive Meeting on the Server. An archived meeting allows other eBeam users to search for, view, download, edit, and/or delete your eBeam meeting (based on the archive privileges you select). If “Archive Meeting on the Server” is checked, the Archive Meeting screen opens after you click the Share button. See also Archiving eBeam Meetings.



Notes: • While the Archive Meeting screen appears after clicking the Share button, your selected archive parameters are not saved to the server until you click the End Meeting button. • During your meeting, you may archive the meeting (or change your parameters) at any time by using the Meeting menu selection, and choosing Archive Meeting. • If you did not check the archive meeting box, you will be prompted at the end of your meeting to archive your meeting to the server. 3. Under “Server Information”, select the server that will host the meeting. The pull-down menu lists the eBeam Server and any other servers you have previously added to your server list. See also: Adding a Meeting Server. NOTE: For Windows, if you wish to host the meeting from your computer, select “Use my PC to host this meeting”, and then type in a port number. For most occasions, the default port value of 80 is best. 4. Notify guests of the meeting name, meeting time, and password, if required. See also: Sending an email invitation to a meeting. 5. Click “Share.” Your shared meeting is now available on the network using the specified meeting server. If a participant is attempting to join a meeting, but is unable to see the meeting name in the Join Meeting dialog box, both the meeting host and participant should check their proxy server settings. See Proxy Server Setup. Also, check to make sure that you checked “Publish Meeting Name” in the Share Meeting dialog box.



See Also: Adding a Meeting Server Proxy Server Setup Hosting Multiple Meetings Sending an email invitation to a meeting Joining a meeting Archiving eBeam Meetings Retrieving Archived eBeam Meetings Adding a Meeting Server When you share or join a meeting, you must choose a meeting server. You can enter the server information each time, or you can create a list of frequently used servers and select from this list whenever you share or join a meeting. To add a meeting server to your list: 1. Choose “Share Meeting” or “Join Meeting” from the Meetings Menu or from the Application



Toolbar. 2. In the Share Meeting or Join Meeting dialog box under Server/Server Information, click the server button alongside the server pull-down list. The Meeting Servers dialog box opens. 3. Click the “Add” button. 4. Type the server name, the DNS name or IP address of the server you want to add to your list, and the port number. The default port number is 80. 5. Click OK. The new server is added to the Meeting Servers list. See Also: Proxy Server Setup Proxy Server Setup If your company requires a proxy server, your computer will not be able to access meetings on the eBeam Server (which is outside your company’s firewall) until you enable the proxy server and enter the proxy server settings. The Setup dialog box gives you a place to enter settings for an HTTP proxy server. Proxy servers, which act as intermediaries between individual workstations and the Internet, provide security and other administrative functions for companies that use the Internet. To setup a proxy server: 1. Choose “Setup” from the Edit Menu. 2. Click the “Proxy Server” tab. 3. You have several options for setting up the proxy server:



Configuration Option Automatic Configuration



Selections • Automatically detect proxy server. Attempts to establish a connection with the proxy server by trying to get proxy server information from either the DNS or DHCP servers in your local network. • Use configuration script. Uses a pre-defined network setup script (provided by your IS department) to establish a connection with the proxy server. The script is a file whose URL must be entered into the Address text box. An example of an address is: http://mysever:9090/ proxy.pac.



Manual Configuration



Enter the IP address or DNS name and the Port of the proxy server.



Authentication



Authentication allows you to check “Use Authentication (Basic Only)” checkbox. You then type in your network User ID and Password. In many cases this will allow you to access internet meetings through your proxy server.



Configuration Option



Selections



Use IE Settings



Use IE Settings attempts to get your proxy server settings by looking at the proxy server settings for Internet Explorer on your computer.



Other options



Sometimes it is not possible to locate proxy server settings without going through your IS department. Two more possible options for locating proxy server settings yourself are: • Windows: In Netscape, go to the Edit menu>Preferences. Click Advanced and then click Proxies. If Manual Proxy configuration is checked, click the View button. Use the address and port number listed under HTTP. • Go to the Internet Control Panel, click the Advanced tab, and then the Firewalls icon. All proxy server information is displayed.



If you are unable to find the Proxy information as described above, consult your network administrator. 4. Click OK. Hosting Multiple Meetings eBeam Software’s Meeting application allows you to participate in multiple meetings at the same time. You can display multiple meeting windows, or you can choose to view one meeting at a time. You can host multiple meetings in one of the following ways: • Hosting a meeting on your computer, and hosting a separate meeting from the eBeam server. • Hosting multiple meetings from the eBeam server. • And then join meetings as well. The eBeam hardware must be connected to the meeting that is being shared. To select the meeting you wish to use your eBeam hardware: 1. Choose “Select eBeam meeting” from the Tools Menu. 2. Select the meeting name from the pull-down menu. 3. Click OK.



Sending an email invitation to a meeting You can invite others to a shared meeting by sending an email that contains a link or URL. In order to send email invitations, you must currently be sharing a meeting. Remote participants cannot send out invitations. To send an email invitation: 1. Make sure you are sharing a meeting. See Hosting/Sharing a meeting. 2. Choose “Send Invitation” from the Meetings Menu. This opens the Select Language dialog box.



3. Select the language to be used for the email invitation, and then click Continue. NOTE: Your email program may or may not ask you to select the email profile to be used. An eBeam Meeting Request appears in your email application send mail window. 4. Enter the email addresses of the recipients in the To: field. The email invitation is sent with a link to download the latest eBeam Software and links to enable the user to join the meeting via their web browser or eBeam Software. See Also: Accepting an email invitation Joining a meeting



Joining a meeting There are two ways you can join meetings: • Using the eBeam Software (see To join a meeting as an eBeam user:). • Using a web browser (see To join a meeting as a web user:). To join a meeting as an eBeam user: 1. Choose “Join Meeting” from the Meetings Menu. 2. In the Join Meeting dialog box, select the meeting server, enter your name, and select a meeting name from the “Meeting” list. The “Meeting” list shows active meetings whose names have been published. If the pull-down menu does not include the meeting server you want, you can manually type the server name. You can also add a server to your server list, so that you can quickly select it on another occasion. See Adding a Meeting Server. 3. Click “Refresh” to update the list of published meetings. 4. If the meeting appears with a Lock icon, enter the password. If the meeting is not listed, enter the meeting name, and a password if required. 5. Click “Join.” There are restrictions on what a meeting participant can do within a shared meeting. For details on what you can do while connected to a meeting, see What can a meeting participant do? When the host ends the meeting, participants receive the message “The meeting has ended.” The meeting remains visible on your desktop. Once disconnected, participants still can print, save, annotate, and modify the meeting. If, at any point, you want to leave a meeting, choose Leave Meeting from the Meetings Menu, or click the Leave Meeting icon from the Application Toolbar. To join a meeting as a web user:



1. Launch Internet Explorer. 2. In the “URL” text box (Address or Location), type the IP address or DNS name of the computer hosting the eBeam session. If the meeting is hosted by the eBeam server, type www.e-beam.com and click the “Meetings” button. 3. Type your name in the “My Name” text box, and the meeting name in the “Meeting Name” text box. In the “Meeting Password” text box, type the password, if required. 4. Click “Join a Meeting.” If the meeting is in session, the eBeam window appears in your web browser. Participants will see the full contents of the meeting. Remote participants cannot print or save the meeting to disk. However, the host can save the meeting and make it available to web users for viewing in a web browser or another application. At any point, you can choose “Leave Meeting” from the Meeting menu. See also: Hosting/Sharing a meeting Sending an email invitation to a meeting Accepting an email invitation What can the meeting coordinator do? What can a meeting participant do? Using eBeam Chat



Accepting an email invitation You can accept an email invitation in one of the following ways: • Click the http: link to join through your web browser. • Click the file: link to join through your copy of eBeam Software. The latest version of eBeam Software can be downloaded from the www.e-beam.com downloads page. • Manually open your browser, and copy and paste the link into the browser. See Also: Sending an email invitation to a meeting Joining a meeting Checking For Software Updates



Archiving eBeam Meetings There are two areas in eBeam Software where you can select to archive an eBeam meeting. • While hosting a shared meeting. In the Share Meeting dialog, click the “Archive meeting on the server” checkbox to have the Archive Meeting Screen open after the Share button has been clicked. See Hosting/Sharing a meeting for more information about sharing a meeting. • After creating/completing a meeting, you have the choice of archiving that meeting (to the server) for viewing and/or downloading by other eBeam users or only for those users with password-access. To select this option: • Save the meeting • Choose Archive Meeting from the Meetings menu • Select the server to archive the meeting on and click Continue. The Archive Meeting Screen will open next. Next step: Archive Meeting Screen Archive Meeting Screen Use the Archive Meeting screen to define meeting information, security access requirements, the file access expiration period, and review the Conditions of Use. Meeting Information Section • Meeting Name: Retain the current saved meeting name or create a new name for the archived meeting. • Publish Meeting Name checkbox: Check to have archived meeting published (available for searching) Access Security Section • Password access - check the box to require a specified password before an eBeam user can retrieve your archived meeting. If checked, enter a password, and then re-enter it for confirmation. • Security Code - check the box to require a specified security code before an eBeam user can edit or delete the archived meeting file. Note: if the box is checked, but no security code is specified, the defined password is automatically used.



Access Period Section • The text appearing in this section displays the current expiration period for storing and accessing the archived meeting file. After this time, the file is deleted from the server. • Click the Change button to edit the current criteria via the Access Period screen, as described below. Access Period Screen • Meeting Storage - choose the default, or select a specific date.



• Meeting File Availability - define the duration the archived meeting will be available for other eBeam users to view and/or download. • Always (until deleted) - available until same defined final date as meeting storage date. • During Specific Time Period - specify exact days and times for starting and ending availability. Note: End Date may also be until the file is deleted from the server (see final meeting storage date) by checking the Until Deleted box. • Summary section - text appearing in this section displays the updated expiration period for storing and accessing the archived meeting file. After this time, the file is deleted from the server. Archive Meeting Buttons • Conditions of Use button - click this button to review the conditions of use for the eBeam product. • Help button - click to display the context-sensitive help for this screen. • Archive button - when all your selections are complete, click the Archive button. • Cancel button - click to cancel your archive request. See Also: Hosting/Sharing a meeting Joining a meeting Retrieving Archived eBeam Meetings



Retrieving Archived eBeam Meetings From the Meeting menu selection, you may search and retrieve archived meetings for viewing or downloading at any time. Notes: • To retrieve eBeam meetings, under the Meeting menu, choose Retrieve Meeting. • Some meetings may require password-access. The following topics describe the elements and activities available to you via the Retrieve Archived Meeting screen. Recent Archived Meetings Screen Change Archived Meeting Screen By Meeting Name Screen Full Search Screen



Recent Archived Meetings Screen Use the Recent Archived Meetings screen to list, edit, delete, and/or retrieve previously archived eBeam meetings. Note: editing and deleting a meeting may required a security code. If required, you will be prompted. Select Archived Meeting Server • Use the selector to choose the eBeam server where the archived meeting resides. If necessary, you may also, click the Browser button, and manually search for the server location. Meeting Columns and Options • Time-span selector - choose between displaying Today’s meetings through all meetings archived to the eBeam server within the last 90 days. • Meeting count - displays the number of meeting found, and the meetings displayed. • Meeting Name - name of the archived meeting. • File Size - size of the archived meeting file. • Owner - name of the user workstation that archived the meeting. • Archived - date the meeting was archived to the server. • Expires - date the archived meeting is no longer available for retrieving, editing, etc., and will be permanently deleted from the server. Note: you can sort the meeting list based on any of the above column headings by clicking on any heading. • Refresh button - use at any time to refresh the current meeting list, including any recent meetings archived by other eBeam users. • Retrieve button - after highlighting an archived meeting, click the Retrieve button to retrieve that meeting. Note: a dialog box appears allowing you to open the meeting, download the meeting to a specified location, or cancel your request. • Edit button - after highlighting an archived meeting, if the Edit button is available, you can edit the archive parameters for that meeting. Note: you may be prompted for a password and a security code to edit the meeting. See Change Archived Meeting Screen for screen details. • Delete button - after highlighting an archived meeting, if the Delete button is available, you can delete that meeting. Notes: a password and a security code may be required for deletion. A prompt will appear, asking you to confirm your deletion request. • Close button - click to close the screen. Change Archived Meeting Screen • Use the Change Archive Meeting screen to edit meeting information, security access requirements, and the file access expiration period. Meeting Information Section • Meeting Name - retain or change the current archived meeting name.



• Publish Meeting Name checkbox - check to have archived meeting name published (available for searching). Access Security Section • Password access - check the box to require a specified password before an eBeam user can retrieve your archived meeting. If checked, enter a password, and then re-enter it for confirmation. • Security Code - check the box (default) to require a specified security code before an eBeam user can edit or delete the archived meeting file. Note: if the box is checked, but no security code is specified, the defined password is automatically used. Access Period Section • Meeting Storage - choose the default or select a specific date. • Meeting File Availability - define the duration the archived meeting will be available for other eBeam users to download. Select one of the following. • Always (until deleted) - available until same final date as defined file storage date. • During Specific Time Period - specify exact days and times for starting and ending availability. Note: End Date may also be until the file is deleted from the server (see final storage date) by checking the Until Deleted box. • Summary section - text appearing in this section displays the updated expiration period for storing and accessing the archived meeting file. After this time, the file is deleted from the server. Change Archived Meeting Buttons • Help button - click to display the context-sensitive help for this screen. • Apply button - when all your selections are complete, click the Apply button. • Cancel button - click to cancel your edit request. By Meeting Name Screen Use this screen to retrieve a specifically defined archived meeting. Select Archived Meeting Server • Use the selector to choose the eBeam server where the archived meeting resides. If necessary, you may also, click the Browser button, and manually search for the server location. Archived Meeting Name and Password • Meeting Name - enter the exact name of the archived meeting. Note: this entry is casesensitive. • Password - if required, enter the case-sensitive password for the desired archived meeting. • Retrieve button - click the Retrieve button to retrieve that meeting. Note: a dialog box appears allowing you to open the meeting, download the meeting to a specified location, or cancel your request.



Meeting Name Buttons • Retrieve button - after entering the exact name of the archived meeting, click the Retrieve button to retrieve the meeting. Note: a dialog box appears allowing you to open the meeting, download the meeting to a specified location, or cancel your request. • Edit button - after entering the exact name of the archived meeting, if the Edit button is available, you can edit the archive parameters for that meeting. Note: you may be prompted for a password and a security code to edit the meeting. • See Change Archived Meeting Screen for screen details. • Delete button - after entering the exact name of the archived meeting, if the Delete button is available, you can delete that meeting. Notes: a password and a security code may be required for deletion. A prompt will appear, asking you to confirm your deletion request. • Close button - click to close the screen. Full Search Screen Use the Full Search screen to locate one or more archived meetings by meeting name, owner name, and/or date and time. Select Archived Meeting Server • Use the selector to choose the eBeam server where the archived meeting resides. If necessary, you may also, click the Browser button, and manually search for the server location. Search Criteria Options Note: you may select one or more of the search options described below. • Search by Meeting Name - enter archived meeting name. Note: using checkbox and buttons below, this name may be case-sensitive, and/or entered exactly, partially, or begin with the first letters for the search. • Search by Owner Name - enter the name of the owner workstation of the archived meeting. Note: using checkbox and buttons below, this name may be case-sensitive, and/or entered exactly, partially, or begin with the first letters for the search. • Case-sensitive Search checkbox - check to have Meeting and/or Owner Name entry search be case-sensitive. • Exact Name - click to have search find archived meetings that exactly match the Meeting and/or Owner Name entry. • Name Starts with - click to have search find meetings that start with the Meeting and/or Owner Name entry. • Name Contains - click to have search find meetings that contain some portion of the Meeting and/or Owner Name entry. • Search by Archiving Date/Time - use this section to define date/time ranges for searching archived meetings. • From Date - select the beginning date for the meetings you want to retrieve. Note: you may also click on the calendar icon to automatically enter a date. • To Date - select the ending date for the meetings you want to retrieve. Note: you may also click on the calendar icon to automatically enter a date.



Search Result Columns • Meeting Name - name of the archived meeting. • File Size - size of the archived meeting file. • Owner - name of the user workstation that archived the meeting. • Archived - date the meeting was archived to the server. • Expires - date the archived meeting is no longer available for downloading, editing, etc., and will be permanently deleted from the server. Note: you can sort the meeting list based on any of the above column headings by clicking on any heading. Full Search Screen Buttons • Search button - when you have completed all your selections, click Search. The results are displayed in the Search Results section. • Retrieve button - after highlighting an archived meeting, click the Retrieve button to retrieve that meeting. Note: a dialog box appears allowing you to open the meeting, download the meeting to a specified location, or cancel your request. • Edit button - after highlighting an archived meeting, if the Edit button is available, you can edit the archive parameters for that meeting. Note: you may be prompted for a password and a security code to edit the meeting. See Change Archived Meeting Screen for screen details. • Delete button - after highlighting an archived meeting, if the Delete button is available, you can delete that meeting. Notes: a password and a security code may be required for deletion. A prompt will appear, asking you to confirm your deletion request. • Close button - click to close the screen. See Also: Hosting/Sharing a meeting Joining a meeting Archiving eBeam Meetings



What can the meeting coordinator do? The meeting coordinator/host is the person responsible for setting up and broadcasting the shared meeting. In the course of the shared meeting, the meeting coordinator can do anything eBeam Software’s meeting application can do: draw whiteboard strokes, create annotations, create new pages, delete pages, etc. When the coordinator/host closes a shared meeting, all participants are disconnected. As the meeting coordinator, make sure the meeting is completely over before attempting to close the meeting. The following special features allow the meeting coordinator to control the shared meeting:



Feature Synchronize



Description Forces all participants to view the same page as the meeting host. If synchronize is disabled, remote participants can view any page they wish during the meeting. If synchronize is enabled, remote participants are unable to change pages. However, if synchronize is enabled, remote participants can annotate pages. The synchronize feature is located in the Meetings Menu. A checkmark indicates that synchronize is enabled. A synchronize button is also available on the page view toolbar (see Views and the view-change buttons). When synchronize is enabled, the button is depressed.



Set View Only



Allows the coordinator to mute one or more of the remote participants. When a particular remote participant is muted, the participant cannot add annotations to the meeting page (Annotation Tools). However, the participant can still type comments into the Participants/Chat View (Views and the view-change buttons). The meeting coordinator cannot be muted. Set View Only can be accessed from the Meetings Menu or the Application Toolbar. You must be in the Participants/Chat view, and have selected one or more participant name(s). The Meetings Menu and Application Toolbar also contain a Set View Only-All option, which allows you to mute all participants at once.



Exclude



Allows the coordinator to disconnect a meeting participant from the shared meeting. Exclude can be accessed from the Meetings Menu or the Application Toolbar. To use this feature, you must be in the Participants/Chat view and have selected one or more participant name(s).



See Also: Web Tour What can a meeting participant do?



What can a meeting participant do? As a remote participant, you have connected to an active meeting (see Joining a meeting) and the full shared meeting from the host computer is displayed on your computer. A remote participant does not have the same set of features as the meeting coordinator. Features that are different for a participant are described below.



Feature Synchronize



Description If the meeting coordinator has not enabled synchronize, remote particpants can view and scroll the pages in the meeting independent of other users. If the meeting coordinator has enabled synchronize, remote particpants are only able to view the page that the coordinator is viewing. However, remote particpants are still able to annotate the page.



Set View Only



If the meeting coordinator has set a remote particpants to View Only, the participant cannot annotate the page.



Page functions



For remote particpants, New Page, Duplicate Page, Clear Page, and Delete Page are disabled.



Feature Annotation



Description Remote particpants cannot erase or undo annotations made by other participants.



See Also: What can the meeting coordinator do? Views and the view-change buttons Using Annotation Tools during a Shared Meeting



Using eBeam Chat The Participants View is used to display all participants who are logged into a shared eBeam Meeting, as well as to allow the participants to chat online during the meeting. To access the Participants View either click the “Switch To Participants View” button (see Views and the viewchange buttons), or choose “Participants” from the View Menu. The Participants View contains two sections: the Chat Window and the Participants List. Chat Window The Chat Window allows participants in a shared meeting to send text messages to one another in the course of the meeting. Messages can be sent to anyone listed in the Participants List, by typing a text message into the New Message text box, and then clicking one of the buttons listed next to “Send To.” The following controls are contained in the Chat Window:



Control



Description



New Message



Creates a new email message. Type the new outgoing text message into the “New Message” text box, and then select “All” or “Selected Participants” to send the message. See All and Selected Participants.



Show Addressee



Lists the name(s) of email recipients. If “Show Addressee” has been checked, once a text message has been sent, the participant(s) that the message was sent to are listed next to the message. For incoming messages, the sender’s name is always listed next to the message.



Show Time



Lists the time of email messages. If “Show Time” has been checked, once a text message has been sent, the time the message was sent to is listed next to the message.



Color Coded



If “Color Coded” has been checked, then incoming/outgoing text messages are color coded in the Chat Window. The color codes are defined as: • Black – Incoming text message. • Blue – Outgoing text message. • Red – Priority text message. Incoming and outgoing.



Priority Message



Color codes a high-priority message. If “Priority Message” has been checked, the outgoing/incoming message is displayed in red. If “Color Coded” is not checked, the message is displayed in black.



Control



Description



All



Sends the text message in the “New Message” text box to all connected participants. This button is disabled until a text message has been typed into the “New Message” text box.



Selected Participants



Sends the text message in the “New Message” text box to all selected participants in the Participants List. Multiple participants can be selected/ deselected by holding down the Shift or Control button. This button is disabled until a text message has been typed into the “New Message” text box.



Clear



Clears all previously sent/received test messages from the Chat Window. However, does not clear any text in the “New Message” text box.



To show/hide the Chat Window, click the green arrow located next to the Chat title. See Also: What can the meeting coordinator do? What can a meeting participant do? Shared Meetings Participants List The Participants List displays a list of all participants in a shared meeting. For each participant, the following information is displayed:



Item



Description



Participant Name



The name of the participant as entered in the “My Name” text box in the Join Meeting dialog box. See Joining a meeting.



Write Permission



Write permission is displayed by an icon. When the participant has permission to annotate the meeting, a pen icon is displayed. When the participant does not have permission to annotate the meeting, the pen icon is displayed with a line through it. See Also: What can the meeting coordinator do?, What can a meeting participant do?.



Connected At



Displays the time the participant connected to the meeting.



IP Address



Displays the participant’s IP Address.



Notes



Displays any notes entered into the Notes field in either the Share Meeting or Join Meeting dialog box. See also: Hosting/Sharing a meeting, Joining a meeting.



See Also: What can the meeting coordinator do? What can a meeting participant do? Shared Meetings



Web Tour eBeam Software’s Web View allows you to access web pages on the internet from the eBeam Software’s meeting application. Web View is itself a web browser which provides the most commonly used web browser controls, as well as allowing access to your “Favorites” links (see Favorites), or allowing you to set your home page (see Web Tour Setup). Web View does not allow pop-up windows. If you visit a website that contains pop-up windows a warning dialog box will appear informing you that pop-up windows are not supported. The Web Tour feature is controlled from within Web View and allows you to lead participants in a shared meeting from one web page to another. Each time you go to a new URL, your guests automatically go with you. Note: Web Tour is not supported in the browser version of eBeam Software (accessed by joining a meeting through www.e-beam. com > Meetings). To use Web Tour: 1. Click the Web View button from the Views and the view-change buttons. 2. Click the Synchronize Participants button. NOTE: Synchronization is required for Web Tour. 3. Type in a web URL, or select an address from Favorites.



4. To set a home page, see Web Tour Setup.



Web View Toolbar The Web View toolbar contains the following controls: Back



Stop



Home



Web Page URL



Snapshot



Forward Refresh Favorites



Control Back



Go



Update participants



Description Displays the previous viewed web page. Back is disabled while you have viewed only one web page.



Forward



Return to the web page you were viewing before you clicked Back. Forward is enabled only when you have used the back button.



Stop



Stops loading a web page.



Refresh



Reloads the current web page.



Home



Opens the Home page. When you are using eBeam Software, eBeam’s web page is the home page. To set your home page, see Web Tour Setup.



Favorites



Displays your list of favorite websites. The addresses are gathered from your Windows Favorites directory.



Web Page URL



Displays the URL of the current web page as a pull-down list. To go to a new web page, type in a new URL or select a URL from the pull-down list, and then click Go.



Snapshot



Takes a snapshot of the web page currently shown in the Web View and loads it into the background of a new page in your meeting. This feature is especially useful for building presentations, because once the web page has been pulled in to a background image, you can annotate it using the Annotation Tools.



Go



Opens the web page listed in the Web Page URL pull-down list.



Update Participants



Synchronizes the other participants to the current web page. This feature is available to the host once the Synchronize Participants button has been clicked.



See Also: Web Tour Setup Views and the view-change buttons Hosting/Sharing a meeting What can the meeting coordinator do?



Web Tour Setup You can set the Web Tour home page and clear your history list from Web Tour Setup. Web Tour Setup is accessed by choosing Setup from the Edit menu, and selecting the Web Tour Setup tab.



Microsoft NetMeeting If you are a Microsoft Windows NetMeeting user, you can use the eBeam system as input for a NetMeeting. To use Netmeeting with eBeam: 1. Install NetMeeting software (available separately) on you computer. 2. Set up the eBeam system as described in your setup guide. 3. Launch eBeam Software’s Meeting application and make sure the eBeam Software is connected to the eBeam hardware. NOTE: If you were in Projection mode just prior to launching eBeam Software’s Meeting application, switch to Whiteboard mode (see How to Select a Mode). 4. Choose “Microsoft NetMeeting” from the Tools Menu. NetMeeting starts, and the NetMeeting whiteboard is displayed on your computer. 5. Using any of the eBeam system’s electronic pens, write on your whiteboard. Your strokes are recorded in the NetMeeting Whiteboard. 6. Alternatively, you can use NetMeeting with your projection system in Projection mode. For detailed help with Microsoft NetMeeting, access the Microsoft NetMeeting help system or Microsoft’s website.



eBeam Software’s Projection mode eBeam Software’s Projection mode turns your whiteboard into a virtual touchscreen. Projection mode is best used as a presentation device, which allows you to open, close, and show anything you need directly from the whiteboard, instead of having to walk between you computer and whiteboard whenever you need to change something. For details on how to put eBeam Software in Projection Mode, as well as the other available modes, see How to Select a Mode. The eBeam system and the projector connect to your computer. The projector displays your computer desktop onto the whiteboard and the eBeam system detects when you touch the board, allowing an electronic pen (using the plastic stylus insert) to act as a virtual mouse which controls your computer’s desktop. The purpose of Projection mode is to operate your computer directly from the whiteboard. In Projection mode, you can: • Open, work in, and close applications. • Draw freehand in painting and drawing applications. • Run eBeam Software’s meeting application directly from the whiteboard, including sharing meetings while controlling the entire meeting directly from the whiteboard. • Annotate over the top of your desktop using the Projection Toolbar (see Annotating your desktop).



As shown in the image above, your computer is attached to the eBeam hardware (eBeam system 1 shown), and is also attached to the projector. The projector projects your computer desktop onto the whiteboard. In projection mode, a tap of the electronic pen on the whiteboard simulates a mouse click on your computer desktop. You can open, close, annotate, and save in an application from the whiteboard just as you would in front of your computer. A plastic stylus is provided with your eBeam system package. The stylus is a plastic insert which fits into any electronic pen and allows you to use the electronic pen as a point and click device, instead of as a marker. This is useful during a presentation when you wish to select different areas of the projected screen, without leaving dry-erase marker marks on the whiteboard. Optionally, your eBeam system package may come with eBeam’s new Projection Pen. eBeam Software’s Projection mode



See Also: Projection Toolbar Annotating your desktop Using Whiteboard mode and Projection mode together.



Projection Toolbar The Projection Toolbar is used to control the most commonly used functions when in eBeam Software’s Projection mode.



Calibrate Select Mode



Annotate Right your desktop Click



Hide Projection Toolbar



On-Screen Keyboard



The following functions can be accessed from the Projection Toolbar.



Button



Description



Annotate your desktop



Opens the Screen Annotation toolbar and allows you to annotate your computer desktop. See Annotating your desktop.



Calibrate



Opens the Projection mode calibration wizard. See Calibration.



Right Click



Opens right-click menus or right-click functions when using an electronic pen in Projection mode. To use, tap the Right Click button. The next time you tap the whiteboard with the electronic pen, eBeam Software will capture the tap as a right-click, and will perform the appropriate right-click function.



Select Mode



Displays a mode select menu. See How to Select a Mode.



On-Screen Keyboard



Opens the on-screen keyboard for use in Projection mode. This is supported only if your operating system has a built-in on-screen keyboard and it is enabled.



Hide Projection Toolbar



Closes/hides the Projection Toolbar. eBeam Software remains in Projection mode.



See Also: Annotating your desktop How to Select a Mode Calibration eBeam Software’s Projection mode



Annotating your desktop eBeam Software’s Projection mode allows you to annotate your computer desktop. You open the Screen Annotation toolbar from the Projection Toolbar, which can be accessed from eBeam’s Windows system tray menu. It is important to understand that once the Screen Annotation toolbar appears, eBeam Software is in a screen annotation mode, which means the following: • You can annotate anywhere on the desktop using tools from the Screen Annotation toolbar. • You can Save to a bitmap file, Print, or Copy to the system clipboard annotations that you have created. • You cannot open applications or use any of your computer’s other functions/features. This is because the screen annotation mode takes a snapshot of your desktop and then puts the snapshot on top of your computer desktop for you to draw on. You draw on the snapshot layer, and the desktop itself remains protected under the layer. To exit Annotation mode and go back to using your computer’s other functions, you simply click the Exit button on the Screen Annotation toolbar. Pen



Eraser



Highlighter



Select Area Redo



Shapes



Undo



Save



Undo/ Redo All



Print



Copy



Exit



The following tools are provided on the Screen Annotation toolbar:



Tool



Description



Pen



Allows you to annotate your desktop freehand in any color supported by your operating system. Clicking the arrow next to the Pen tool opens a palette of pen options: Pen color, line thickness, and smooth lines.



Highlighter



Allows you to highlight your desktop freehand in any color supported by your operating system. Clicking the arrow next to the Highlighter tool opens a palette of highlighter options: Highlighter color, and line thickness.



Eraser



Allows you to erase (from your desktop) any marks made with tools from the Screen Annotation toolbar. The eraser size can be selected from the palette that appears when the arrow next to the Eraser tool is clicked.



Shapes



Allows you to use several different standard shapes (circle, square, arrows, etc.) to annotate your desktop in any color supported by your operating system. Clicking the arrow next to the Shapes tool opens a palette of shape options: Select shape, color, line thickness, smooth lines, and whether or not to make the shape semi-transparent. Semi-transparent allows you to read text and see lines through the shape lines.



Select Area



Allows you to draw a selection rectangle around an area on the desktop which can then be saved, copied, or printed using the Save, Copy, or Print tools from the Screen Annotation toolbar.



Undo



Erases the previous annotation. It is possible to undo until all annotations have been removed.



Tool Redo



Description Redoes the last undone annotation. In the case of multiple undos, it is possible to redo back to the final annotation on the desktop. Once the next new annotation occurs, Redo is disabled. Redo is available when Undo was previously clicked.



Undo/Redo All Save



This button remains Undo All until all annotations have been removed from the screen. Once all annotations have been removed from the screen, the button becomes Redo All. Saves either the entire desktop, or the selected area of the desktop to a bitmap file. A save option menu can be accessed by clicking the arrow attached to the Save tool. If you have previously used the Select Area tool to outline an area on your desktop, then the option to “Save Selected Area...” is the default choice from the menu, and only the selected area is saved to file. If you have not outlined an area, then the default is to “Save Whole Screen...” which saves the entire displayed desktop to file. Each time Save is clicked, the standard Save As dialog box opens allowing you to enter a meeting name and select the folder location.



Copy



Copies either the entire desktop, or the selected area of the desktop to your operating system’s clipboard. Data copied to the operating system’s clipboard can later be pasted to other applications, such as Paint, Word, etc. A copy option menu can be accessed by clicking the arrow attached to the Copy tool. If you have previously used the Select Area tool to outline an area on your desktop, then the option to “Copy Selected Area to Clipboard” is the default choice from the menu, and only the selected area is copied to the operating system’s clipboard. If you have not outlined an area, then the default is to “Copy Whole Screen to Clipboard” which copies the entire displayed desktop to the operating system’s clipboard.



Print



Prints either the entire desktop, or the selected area of the desktop to a printer that you select. The printer must already be set up on your operating system. A print option menu can be accessed by clicking the arrow attached to the Print tool. If you have previously used the Select Area tool to outline an area on your desktop, then the option to “Print Selected Area...” is the default choice from the menu, and only the selected area is printed. If you have not outlined an area, then the default is to “Print Whole Screen...” which prints the entire displayed desktop.



Exit



Closes screen annotation mode, hides the Screen Annotation toolbar, and returns eBeam Software to the standard Projection mode. Before screen annotation mode closes, a message dialog box appears that informs you that all annotations will be lost. If necessary, click No and use the Save, Copy, and Print tools to save your annotations. Otherwise, click Yes to return to eBeam Software’s Projection mode.



See Also: Projection Toolbar How to Select a Mode Calibration eBeam Software’s Projection mode



eBeam’s Windows system tray menu The eBeam Software menu appears as an icon in the Windows system tray even when you are not using eBeam Software. The following menu items are offered from the system tray:



Menu Item



Description



Capture from Whiteboard



Puts eBeam Software in Whiteboard mode and launches eBeam Software’s meeting application used to collect whiteboard data. See What is Whiteboard mode?



Capture from Flipchart



Puts eBeam Software in Flipchart mode and launches the meeting application used to collect flip chart data. See What is Flipchart mode?



Use with Projector



Puts eBeam Software in Projection mode. Your electronic pen now acts as a virtual mouse. See What is Projection mode?



Disable System



Disconnects eBeam Software from the hardware, freeing the communication port on your computer. You can still use eBeam Software’s meeting application. When the hardware is disconnected (or cannot be detected), you will see a red line through the eBeam icon in the system tray. See Icons that represent a mode.



Projection Toolbar



Provides access to all Projection mode functions. When eBeam Software is in Projection mode, the Projection Toolbar provides access to all Projection mode functions. See Projection Toolbar. A checkmark next to “Show Projection Toolbar” indicates that the toolbar is displayed. Also can be used to access the Annotating your desktop features.



Annotate Screen



Opens the Scren Annotation Toolbar. See Annotating your desktop.



Show On-Screen Keyboard



Displays On-Screen Keyboard menu. If an on-screen keyboard is supported and installed on your operating system, the On-Screen Keyboard menu option causes the On-Screen Keyboard to be displayed and allows it to be used in Projection mode.



Projection Mode Settings...



Opens the Projection Setup dialog box. This dialog box allows you to turn on/off various warning messages.



Calibrate Projection Area...



Initiates the Projection mode calibration wizard. See Calibration.



System Setup



See Setup.



Detect System



Attempts to detect the hardware. See How to Connect.



Calibrate Capture Area



Opens the hardware calibration wizard. See Calibration.



Help



Opens the eBeam Software help system.



Exit



Completely closes down eBeam Software and removes the eBeam icon from the system tray.



See Also: How to Select a Mode Calibration eBeam Software’s meeting application eBeam Software’s Projection mode



Using the Shortcut Strip The Shortcut Strip lets you issue various page commands directly from the whiteboard or flipchart without having to go to your computer. With the Shortcut Strip mounted on your whiteboard within the image area, you can print a page or start a new page with a tap of the electronic pen on the strip on the whiteboard or flipchart. eBeam Software works with two different Shortcut Strips: Shortcut Strip for Whiteboard mode. See Shortcut Strip for Whiteboard mode. Shortcut Strip for FlipChart mode. See Shortcut Strip for Flipchart mode.



Shortcut Strip for Whiteboard mode Every eBeam system ships with the Whiteboard mode Shortcut Strip ships. This Shortcut Strip allows you to issue New Page and Print Page commands directly from your whiteboard without having to go to your computer.



To set up and use your Shortcut Strip, see the following topics: To Set up the Shortcut Strip for Whiteboard mode: Disabling the Shortcut Strip in Whiteboard mode Using the Shortcut Strip in Whiteboard mode To Set up the Shortcut Strip for Whiteboard mode: 1. Peel the Shortcut Strip off its backing and apply the strip along an edge of the image area. The Shortcut Strip is best positioned along the bottom or side edge. 2. Open the Shortcut Strip calibration dialog box by choosing “Shortcut Strip>Calibrate” from the Tools menu. 3. When indicated by the on-screen calibration dialog box, tap the upper-right and then lowerright corners of the Shortcut Strip with an electronic pen.



4. Click OK in the calibration dialog box or wait for the timer to expire. eBeam Software’s meeting application now shows the location of the Shortcut Strip within the Active Page. eBeam Software saves the calibrated location of the Shortcut Strip from one session to another. Disabling the Shortcut Strip in Whiteboard mode If you remove the Shortcut Strip from the whiteboard, you must also disable it in the software. While the Shortcut Strip is still enabled in the software, even though you have physically removed the strip from the whiteboard, tapping any area on the whiteboard (with an electronic pen) previously calibrated as the Shortcut Strip area will appear to eBeam Software’s meeting application to be a New Page or Print Page command. There are two methods of determining whether the Shortcut Strip is enabled or disabled: • Check whether the Shortcut Strip icon appears in the Active Page. If the icon appears, the Shortcut Strip is still enabled. • Check the menu by choosing “Shortcut Strip” from the Tools menu. If there is a checkmark by the Enable menu option, then the Shortcut Strip is still enabled. To disable the Shortcut Strip, choose “Shortcut Strip>Enable” from the Tools menu. The checkmark to the left of the Enable menu item disappears and the Shortcut Strip icon disappears from the Active Page. If you enable the Shortcut Strip again during the same meeting session, the location of the Shortcut Strip is restored without having the calibrate. However, if you close and then re-launch eBeam Software’s meeting application, you must recalibrate. If you change the location of the Shortcut Strip on the whiteboard at any time, you must recalibrate. Using the Shortcut Strip in Whiteboard mode During your meetings, you will frequently want to print a page or erase the board and begin a new page.



Once you have calibrated the Shortcut Strip, one tap on the Shortcut Strip with an electronic pen performs the following actions:



New Page



Print Page



Icon New Page



Description Saves the current page and displays a new blank page on your computer screen. Use this feature when you want to erase the board and start a clean page.



Print Page



On a Windows computer, prints one copy of the active page to the default printer of the attached computer.



Shortcut Strip for Flipchart mode The Shortcut Strip attached to the flipchart clip allows you to issue Next Page, Previous Page, and Print Current Page commands while in Flipchart mode without going to your computer or leaving the flipchart. Because the Shortcut Strip is embedded into the flipchart clip, eBeam Software automatically knows the location of the Shortcut Strip, making it unnecessary to calibrate the Shortcut Strip itself. Using the Shortcut Strip in Flipchart mode When using the flipchart clip, it is wise to place your computer where you can see which page is displayed in the eBeam Software flipchart meeting. In Flipchart mode, the page displayed in eBeam Software is the Active Page. It is important that the page displayed in eBeam Software is the same page that you are modifying on the flipchart.



Icon Next Page



Description The top box on the Shortcut Strip is the “Next Page” shortcut. If the most recent flip chart meeting page is displayed in eBeam Software, the Next Page shortcut creates a new empty page in eBeam Software’s Flipchart mode. Tap the shortcut with an electronic pen to issue a Next Page command. If a previous flip chart meeting page is displayed in eBeam Software, the Next Page command causes the next page in the meeting to be displayed.



Previous Page



The middle box on the Shortcut Strip is the “Previous Page” shortcut. If the first page in the flip chart meeting in not displayed in eBeam Software, the Previous Page shortcut causes the previous page in the flip chart meeting to be displayed. Tap the shortcut with an electronic pen to issue a Previous Page command. If the first page in the flip chart meeting is displayed in eBeam Software, the Previous Page command is ignored.



Print Page



The bottom box on the Shortcut Strip is the “Print Current Page” shortcut, which prints the currently displayed page in eBeam Software. Tap the shortcut with an electronic pen to issue a print current page command to the printer connected to your computer.



Troubleshooting Troubleshooting provides solutions for known issues with the eBeam system. This section covers the Windows versions of eBeam Software. Refer to the following headings: eBeam Hardware Detection/Use Network Connection/Shared Meetings Writing/Data Capture Shortcut Strip eBeam Meeting Applet Background Images



eBeam Hardware Detection/Use How eBeam Software connects to the hardware is described in Connecting eBeam Software to the hardware. See the table below for frequently asked questions about detecting the hardware.



Message



eBeam



“eBeam not found. Check connection cable and power supply.”



Hardware



(This message might appear at application startup, or during the course of a meeting.)



Try the following: eBeam System 1 • Check that all eBeam cables are connected as shown in the setup instructions. The RS-232 to RJ-11 cable should be attached to your computer, and to the right eBeam receiver. The cable attached to the left eBeam receiver should be plugged into the right receiver. The power cable should be plugged into the back of the RS-232 connector, and plugged into an electrical outlet. Click Retry. • Check for the green LED on the left eBeam receiver. If the LED is not lit, this indicates that the eBeam hardware is not getting any power. Check that all cables are connected properly (described above). Click Retry. • Disconnect and reconnect the RS-232 to RJ-11 cable from the right receiver, and then click Retry. eBeam System 3 Serial • Check that all eBeam cables are connected as shown in the setup instructions. The RS-232 to RJ-11 cable should be attached to your computer, and to the eBeam receiver. The power cable should be plugged into the back of the RS-232 connector, and plugged into an electrical outlet. Click Retry. • Check for the green LED on the eBeam receiver. If the LED is not lit, this indicates that the eBeam hardware is not getting any power. Check that all cables are connected properly (described above). Click Retry. • Disconnect and reconnect the RS-232 to RJ-11 cable from the receiver, and then click Retry. eBeam System 3 USB • Check that the USB cable is attached to the eBeam receiver and to your computer. Click Retry. • Check for the green LED on the eBeam receiver. If the LED is not lit, this indicates that the eBeam hardware is not getting any power. Try disconnecting and reconnecting the USB cable, and then click Retry. • If the LED is still not lit, did the Add New Hardware wizard open? If it did, follow the instructions in the dialog box. If Windows is unable to automatically find the requested driver (hidden.drv), and you do not have the Windows installation CD, browse to c:\Windows\system or c:\Windows\system32. Do not cancel before the driver installation is complete, or the eBeam hardware will lose power. eBeam System 3 Bluetooth Wireless • Make sure that the COM Port specified in eBeam Software is the same as the Bluetooth COM Port chosen by your Bluetooth Management software. To check the COM Port setting in eBeam Software, go to Tools > eBeam Hardware > Setup... • Check your Bluetooth Management software (provided by the Bluetooth adaptor manufacturer) and ensure that you are connected to the eBeam System. If not, try to connect to it again. • Check that the blue, circular LED on your eBeam Receiver is on. If the LED is not lit, the eBeam Receiver is not getting any power. Make sure all cable connections are secure until the LED comes on. The LED will first turn green and then blue. • Disconnect and reconnect the USB cable from the Receiver and then click Retry.



Message



eBeam Software



Try the following: • First check the hardware for your system as described above, and then click Cancel. • See Unable to detect the hardware. • Do you have more than one copy of eBeam Software installed on your computer? If so, the other copy may be running and have control of the port. Shut down the other copy. We recommend that old versions of eBeam Software be uninstalled from your computer. • Exit the eBeam Software’s meeting application and restart it. • Check that the eraser is not resting on the eraser pad. • If you are using a Serial-to-USB connector, follow the manufacturer’s set-up instructions.



Message Status Line Message.



eBeam Software



“Could not autodetect eBeam Hardware.” or “Could not connect to eBeam Hardware on X.” (where X is a port).



Try the following: • See “eBeam not found. Check connection cable and power supply.” (This message might appear at application startup, or during the course of a meeting.) • See Unable to detect the hardware.



(This message would most likely occur when you have selected Cancel from the “eBeam not found” message dialog box.)



Message Status Line Message. “Calibration failed. Check power and cables.” (This message would most likely occur when you first launch eBeam Software, or have selected Retry from the “eBeam not found” message dialog box. Only seen with eBeam system 1.)



eBeam Hardware



Try the following: • Message displayed if the eBeam hardware is detected, but the receivers can’t “talk” to each other. Check the cable connections on the right receiver. Make sure nothing is interfering between the receivers.



Message “The eBeam hardware is currently used by Projection mode. Would you like to use the eBeam hardware for this application?”



eBeam Software



Try the following: • Message displayed if you are trying to open or switch to eBeam Software’s meeting application from Projection mode. See How to Select a Mode.



(This message might appear at application startup, or after selecting “Capture from Whiteboard.”)



Troubleshooting



Network Connection/Shared Meetings



Message “To share a meeting, the eBeam Hardware must be connected and detected.”



eBeam Software



Try the following: • To serve as the meeting host, your computer must be attached to the eBeam Hardware. See Hosting/Sharing a meeting.



(This message appears when you choose “Share Meeting.”)



Problem Unable to Share or Join a meeting over the eBeam meeting server.



eBeam Software



Try the following: • If you are attempting to share a meeting, make sure that you have the eBeam Hardware connected. See Hosting/ Sharing a meeting. • If your network/internet connection is behind a firewall or proxy server, you will have to set up the proxy server. See Proxy Server Setup.



Problem Using a cable modem or dsl and unable to Share or Join a meeting over the eBeam meeting server.



eBeam Software



Try the following: • If you are attempting to share a meeting, make sure that you have the eBeam Hardware connected. See Hosting/ Sharing a meeting. • If your network/internet connection is behind a firewall or proxy server, you will have to set up the proxy server. See Proxy Server Setup. Even if you think you aren’t behind a proxy server/firewall, you might be. Your ISP might have a firewall set up, causing this problem. Try: • Add a new server (see Adding a Meeting Server) with a DNS: meetings.e-beam.com, and port: 443. • This option is only available in version 2.1 and later. Newer versions of the software automatically attempt to connect through port 443, but it may be necessary to manually set up the server as described previously.



Problem Unable to see shared meeting names in the Join Meeting dialog box.



eBeam Software



Try the following: • When the meeting host shares the meeting through the “Share Meeting” dialog box (see Hosting/Sharing a meeting), they can select whether or not to publish the meeting name. If the meeting name is published, then it will show up in the “Join Meeting” dialog box. If the meeting name is not published, then other meeting participants must manually type the meeting name into the meeting name text box. • To publish the meeting name, make sure that the “Publish meeting name” checkbox in the “Share Meeting” dialog box is checked. • Does your intranet have a proxy server/firewall? Most intranets do. If you have not done so, enable your proxy server. See Proxy Server Setup.



Problem How to set up the proxy server?



Troubleshooting



eBeam Software



Try the following: • See Proxy Server Setup.



Writing/Data Capture



Problem Software states that the eBeam hardware is detected, but writing does not appear in eBeam Software’s meeting application Active Page.



eBeam



Try the following:



Hardware



• If using eBeam System 1, check that the cable between the two receivers is connected to both receivers. • Press the electronic pen down on the whiteboard. If you do not hear a faint buzzing, replace the batteries. • Try another electronic pen. If the other electronic pen works, replace the batteries in the electronic pen that does not work. • Make sure you are not holding the sleeve too close to the tip of the electronic pen. This blocks the signal.



Software



Problem Software is missing many of the strokes written with the electronic pen.



eBeam Hardware



• Choose “eBeam Hardware>Detect eBeam Hardware” from the eBeam Software’s meeting application Tools menu and then check the status line. If it states that the hardware is not detected see eBeam Hardware Detection/Use.



Try the following: • If using eBeam System 3, check the “feet” on the receiver. These are cones that are designed to detach if the receiver is dropped. Make sure both feet attached and fully seated. • Press the electronic pen down on the whiteboard. If you do not hear a faint buzzing, replace the batteries. • Make sure you are not holding the electronic pen too close to the tip. This blocks the signal. • Make sure that you are pressing the electronic pen firmly against the whiteboard when you write. The electronic pen was designed to write with a normal amount of pressure by the writer; however, it is possible to write so softly that the pen does not send out a signal.



Problem Electronic pen strokes are shown in eBeam Software’s meeting application in the wrong color.



eBeam



Try the following:



Hardware



• Make sure you are using the correct color electronic pen. The color of the electronic pen is shown on a color ring located near the tip of the eBeam marker.



Software



• Check the color set for the sleeve in the Sleeve Settings dialog box (see Setting pen colors/line thickness). It is possible to set a different color in the software for any eBeam marker.



Problem Electronic pen strokes made at the bottom of the whiteboard do not appear in eBeam Software’s meeting application.



eBeam Hardware



Eraser does not erase.



• Press the electronic pen down on the whiteboard. If you do not hear a faint buzzing, replace the batteries. • Make sure you are not holding the electronic pen too close to the tip. This blocks the signal. • Make sure that you are pressing the electronic pen firmly against the whiteboard when you write. The electronic pen was designed to write with a normal amount of pressure by the writer; however, it is possible to write so softly that the pen does not send out a signal.



Software



Problem



Try the following:



• Make sure you are writing within the calibrated image area on the whiteboard. See Calibration.



eBeam



Try the following:



Hardware



• Press the eraser down on the whiteboard. If you do not hear a faint buzzing, replace the batteries.



Software



• Choose “eBeam Hardware>Detect eBeam Hardware” from the eBeam Software’s meeting application Tools menu and then check the status line. If it states that the hardware is not detected see How to Connect.



Troubleshooting



Shortcut Strip



Problem Shortcut Strip does not work.



Troubleshooting



eBeam



Try the following:



Hardware



• Press the electronic pen you are using to press the shortcut strip down on the whiteboard. If you do not hear a faint buzzing, replace the batteries.



Software



• Check that the Shortcut Strip is enabled and calibrated. See Using the Shortcut Strip.



eBeam Meeting Applet



Problem Applet does not load.



eBeam Software



Try the following: Internet Explorer • In Internet Explorer, go to Tools>Internet Options. Click the Security tab, and the click Restricted Sites. Click the Custom Level button, and then scroll down the list to Microsoft VM. Make sure that “Disable Java” is not selected. Attempt to open the applet again. • In Internet Explorer, go to Tools>Internet Options, and click the “Delete Files” button. Attempt to open the applet. Netscape • In Netscape, go to File (or Edit)>Preferences. Click the Advanced option, and make sure that “Enable Java” is checked. • In Netscape, go to File (or Edit)>Preferences. Click the Advanced option, and then click Cache. Click both the “Clear Memory Cache” and “Clear Disk Cache” buttons. Attempt to reopen the applet.



Problem While using iVISTA, the applet does not load.



eBeam Software



Try the following: iVISTA and eBeam Software’s meeting application both use port 80 as the default connection port. Try hosting the eBeam meeting over port 81 or some other port value. Try: • From the “Share Meeting” dialog box (see Hosting/Sharing a meeting), select “Use my PC to host this meeting.”, and then type 81 into the Port text box. • Participants attempting to log in to the meeting should type http://meeting_name:81, where meeting name is the name entered in the Meeting Name text box, and 81 is the port value you have entered.



Problem Unable to see shared meeting names in the Join Meeting dialog box.



eBeam Software



Try the following: • When the meeting host shares the meeting through the “Share Meeting” dialog box (see Hosting/Sharing a meeting), they can select whether or not to publish the meeting name. If the meeting name is published, then it will show up in the “Join Meeting” dialog box. If the meeting name is not published, then other meeting participants must manually type the meeting name into the meeting name text box. • To publish the meeting name, make sure that the meeting host checked the “Publish meeting name” checkbox in the “Share Meeting” dialog box. • Does your intranet have a proxy server/firewall? Most intranets do. If you have not done so, enable your proxy server. See Proxy Server Setup.



Troubleshooting



Background Images



Problem Excel spreadsheet did not load properly.



eBeam Software



Try the following: • Is there a graph in the spreadsheet? eBeam Software’s meeting application cannot import a spreadsheet containing a graph. • See Loading an Excel Spreadsheet as a background image.



Problem Background Image quality is bad.



Troubleshooting



eBeam Software



Try the following: • Background images that are sent to the applet meeting viewer are highly compressed to make the image faster to download. Using the eBeam Software’s meeting application is better if you wish for background images to be easy to view.
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